Procedure for Calibration and Equipment Maintenance Version 11
Forensic Biology Section Effective Date: 12/28/2015
Issued by Forensic Biology Forensic Scientist Manager and DNA Technical Leader

Procedure for Calibration and Equipment Maintenance

1.0 Purpose - This procedure specifies the required elements for the performance check, verification and
maintenance of equipment used by the Forensic Biology Section as performed by the DNA Quality Control
Officer or designee(s).

2.0 Scope — This procedure applies to equipment used by the Forensic Biology Section.
3.0 Definitions

e ABI - Applied Biosystems (Life Technologies).

o Critical equipment — Equipment that requires validation, performance check or verification. This is
required prior to initial use by the Forensic Biology Section or as specified in this procedure. Critical
equipment includes the EZ1 Advanced XL BioRobot, QlAgility, ABI 7500, ABI 3130XL, ABI 9700,
bulb thermometers, balances, pipettors, temperature data loggers, biosafety cabinets, chemical fume
hoods, laminar flow benches, and refrigerators/freezers that contain critical reagents.

o FA - Forensic Advantage.

e Purified dH,O - Water that has been deionized and then filtered to the extent that no particle larger than
a nanometer is present in the water.

e NIST Traceable - Sample, equipment or material(s) that has been verified against a National Institute of
Standards and Technology certified sample, equipment or material(s).

e QC Check - Quality control assessment of materials or instrumentation prior to use within the Forensic
Biology Section.

e QCO - Refers to the DNA Quality Control Officer or their designee(s).

4.0 Equipment, Materials and Reagents

e NIST traceable digital thermometer

e Ice Shaver/crusher

e Purified dH,0

e dH,O

o NIST traceable weight set

e Spectral calibration Kits (for ABI 7500 and 3130XL, or equivalent)

¢ Microwave

e ~1000 mL beaker

e Syringe

e Septa

o 10x buffer

o Wipes (delicate task wipes)

e 50 mL conical tube

o 96 well reaction trays

o Pipettes

e Pipette tips

e Matrix standard set DS-33 to analyze automatically the five different colored fluorescent dye-labeled
samples in a single capillary.

5.0 Procedure
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5.1 ABI 3130XL Genetic Analyzers

5.1.1 Maintenance to be Performed by First User of the Day: refer to the Forensic Biology Section
Procedure for Use of the 3130XL Genetic Analyzer.

5.1.2 Weekly Maintenance

5.1.2.1 Weekly Maintenance shall be performed by the QCO. Documentation of such maintenance
shall be noted on the 3130XL Monthly Maintenance Schedule chart. Such documentation
shall be retained in the Section indefinitely and kept in the binder for each specific
instrument which shall be located near that instrument.

5.1.2.2 At the 3130XL instrument, unlink any plates currently on the instrument. If a plate is
linked, «click on the green plate position and then click “unlink.”
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5.1.2.3 Restart the system. At the computer under service console, single click on “restart all.”

Page 2 of 148

All copies of this document are uncontrolled when printed.



Procedure for Calibration and Equipment Maintenance Version 11
Forensic Biology Section Effective Date: 12/28/2015

Issued by Forensic Biology Forensic Scientist Manager and DNA Technical Leader

5.1.24 0Once all areas appear as green squares, start the weekly maintenance.
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5.1.2.,5 Microwave ~500 mL of purified water in a beaker on high for approximately 2 minutes,
until lukewarm and remove from microwave. Do NOT use boiling water.

5.1.2.6 At the 3130XL, push the tray button and wait for the autosampler tray to come to the front
of the instrument. After it comes to a complete stop, and the status light is a steady green,
open the doors.
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5.1.2.7 Remove the anode and cathode buffer and water reservoirs and close the doors.

|
Mounting pin
| ! PDP moioe |
1
Syvinga fitting ! ' PDP mokar cover
L1 h
Waiter seal | | ceptEy R
wesktorg Tl @ 08 | oo
Mounting pin :
P Capllary armay knoo
Pumg chambss
Pump block
Check vaive ., Doutile-tapered fermule
- Amray part
mierconnest fube
Palymar supply tubs
Bufer valve pin
Lower p black
Palymer supply it
hottie cap with Mouning pin
ol
note Cvarfiow hala
Buter Ni-ine
Palymer
supoly bottle b Anode butfer rEservlr
- ——{1& ML anada resarvok)

Elecnde Sics \
)
=
5 W‘a far resEmvoir
-.l.aste|
&

" Water reservair *\i .
Cathode TBSEHC"
(3 ruAning bu en
| i r'""'

{rins&)
L riome posmon

J,J"

Water reservolr '\\‘jl
[I.I'Il._,E!:I'l

5.1.2.8 Discard septa in the biohazard box.

5.1.2.9 Pour contents of the reservoirs down the sink.

5.1.2.10 Using a 24 mL syringe, draw up at least 10 mL of warm purified water.
5.1.2.11 Loosen the syringe fitting and waste fitting knobs.

5.1.2.12 Place the filled (24 mL) syringe in the loosened syringe fitting knob and place the anode
buffer reservoir under the waste fitting and rinse by depressing the syringe plunger slowly
and steadily.

5.1.2.13 Push on the syringe and dispense at least 10 mL of lukewarm water through the syringe
fitting, but do not overflow the anode buffer reservoir.

5.1.2.14 If bubbles are present in the water seal and/or water trap, re-fill the syringe and push
through additional purified water until no bubbles are present.
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5.1.2.15 Tighten the syringe fitting and waste fitting knobs and discard contents from the anode
buffer reservoir.

5.1.2.16 Place the anode and cathode buffer reservoirs and the two water reservoirs into the purified
water that was placed in microwave.

5.1.2.17 Agitate the openings and remove items from water (removing all crystals that may have
formed).

5.1.2.18 Place items on a wipe and, using an additional wipe, dry the anode and cathode buffer
reservoirs along with the 2 water reservoirs. Pour water down sink.

5.1.2.19 Make 1X genetic analyzer buffer from 10X stock.
5.1.2.19.1 Add 5 mL of 10X stock to 50 mL conical tube.
5.1.2.19.2 Add 45 mL purified water.
5.1.2.19.3 Invert the conical tube by hand to mix contents.

5.1.2.19.4 Label with name, date prepared, Forensic Scientist initials, and expiration date
(refer to the Forensic Biology Section Procedure for DNA Reagent Preparation
and Quality Control Procedure for expiration date parameters). If a new lot of
10X buffer was used, add buffer lot number to 3130XL Monthly Maintenance
Form.

5.1.2.20 Add 1X buffer to the fill line of the anode and cathode buffer reservoirs and cap with a
new septa. Add purified water to the fill lines of the water reservoirs and cap with a new
septa as well.

5.1.2.21 At the 3130XL, push the tray button and wait for the autosampler tray to come to the front
of the instrument. After it comes to a complete stop, make sure the status light is a steady
green. Open the doors to the 3130XL.

5.1.2.22 Secure the anode buffer reservoir onto the 3130XL.
5.1.2.23 Place the cathode buffer reservoir and water reservoirs in the designated positions.
5.1.2.24 Check for bubbles in the polymer supply tube, interconnect tube, and array port.

5.1.2.25 If there are bubbles, click on the wizard file on the top of the Foundation Data Collection
Version 3.0 Software. Click on “Remove Bubbles Wizard” and follow the prompted
instructions until no bubbles remain.

5.1.2.26 Once bubbles are no longer present, check to make sure there is sufficient polymer in the
polymer supply bottle.

5.1.2.27 If there is not sufficient polymer, remove the polymer supply bottle, add more polymer
from the refrigerator, and re-secure the polymer supply bottle back on the instrument.
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5.1.2.28 Close the instrument doors and fill in the instrument cleaning log with QCO initials, date,

array usage and maintenance performed. Note any polymer information on the 3130XL
Monthly Maintenance Form (e.g., lot number, expiration date).

5.1.2.29 Change temperature chart on temperature chart recorder and label the chart with the date of

the current week.

5.1.3 Water Wash

5131

5.13.2

5.1.3.3

5134

5.1.3.5

5.1.3.6

5.1.3.7

51338

5139

At the beginning of the first full week of each month, a water wash shall be performed by
the QCO and recorded on the 3130XL Monthly Maintenance Schedule chart.
Documentation shall be retained indefinitely and stored in the binder associated with the
specific instrument and located near the specific instrument, until it is scanned into the
Section shared folder. Additionally, the data for the runs completed that month are
transferred from each instrument to the Section shared folder. The run counter is then reset
to 0 to begin the next month.

At the 3130XL instrument, make sure the plate is unlinked. If a plate is linked, click on the
green plate position and then click “unlink.”

Restart the Collection software: at the computer, under “service console” single click on
restart all.

When all areas are green squares, start with the water wash.

Microwave ~500 mL of purified water in a beaker on high for approximately 2 minutes,
until lukewarm and remove from microwave. Do NOT use boiling water.

Add at least 8 mL of purified water to the extra bottle labeled dH,0.

At the 3130XL, push the tray button and wait for the autosampler tray to come to the front
of the instrument. After it comes to a complete stop, make sure the status light is a steady
green and open the doors.

Remove the anode and cathode buffer reservoirs along with the water reservoirs.

5.1.3.8.1 Discard the septa in the biohazard box.

5.1.3.8.2 Pour the contents of the reservoirs down the sink.

5.1.3.8.3 Place the anode buffer reservoir under the lower block.

On the Foundation Data Collection Version 3.0 (data collection software), click on
“Wizard,” highlight water wash, and run the “Water Wash Wizard.”

Page 6 of 148

All copies of this document are uncontrolled when printed.



Procedure for Calibration and Equipment Maintenance Version 11
Forensic Biology Section Effective Date: 12/28/2015
Issued by Forensic Biology Forensic Scientist Manager and DNA Technical Leader

5.1.3.10 Once the window appears, replace the water bottle with the polymer supply bottle. Do not
continue until the syringe fitting knob is washed.

5.1.3.11 Using a 24 mL syringe, draw up at least 10 mL of lukewarm water.
5.1.3.12 Loosen the syringe fitting and waste fitting knobs.

5.1.3.13 Place the filled syringe in the loosened syringe fitting knob and place the anode buffer
reservoir under the waste fitting.

5.1.3.14 Push on the syringe and dispense at least 10 mL of lukewarm purified water through the
syringe fitting, but do not overflow the anode buffer reservoir.

5.1.3.15 If bubbles are present in the water seal and/or water trap, re-fill the syringe and push
purified water through until no bubbles are present when tightening the knobs.

5.1.3.16 Tighten the syringe fitting and waste fitting knobs.

5.1.3.17 Continue to follow the instructions on the water wash wizard. Click on the “finish” button
when it appears.

5.1.3.18 Place the anode and cathode buffer reservoirs and the two water reservoirs into the purified
water (the following steps may be performed while the water wash wizard is running).

5.1.3.19 Agitate the opening and remove items from water (removing all crystals that may have
formed).

5.1.3.20 Place items on a wipe. Using an additional wipe, dry the anode and cathode buffer
reservoirs along with the two water reservoirs. Pour water down sink.

5.1.3.21 Add 1 X buffer to the fill line of the anode and cathode buffer reservoirs and cap with a
new septa. Add purified water to the fill lines of the water reservoirs and cap with a new
septa as well.

5.1.3.22 At the 3130XL, push the tray button and wait for the autosampler tray to come to the front
of the instrument and come to a complete stop. Make sure the status light is a steady green.
Open the doors to the 3130XL.

5.1.3.23 Secure the anode buffer reservoir on the 3130XL.

5.1.3.24 Place the cathode reservoirs and water reservoirs in the appropriate positions.

5.1.3.25 Check for bubbles in the polymer supply tube, interconnect tube, and array port.
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5.1.3.26 If there are bubbles, click on the Wizard File on the top of the Foundation Data Collection
Version 3.0 software. Then click on “Remove Bubbles Wizard” and follow the prompted
instructions until no bubbles remain.

5.1.3.27 Once bubbles are no longer present, check to make sure there is enough polymer in the
polymer supply bottle.

5.1.3.28 If there is not enough polymer, remove the polymer supply bottle and add more polymer
from the refrigerator. Re-secure the polymer supply bottle on the instrument.

5.1.3.29 Close doors and document the maintenance as noted in 5.1.3.1.

5.1.4 Changing the Capillary Array — when a capillary has repeated ILS (i.e., sizing standard) failure,
or the bases of the alleles in samples broaden (monitor closely once the array usage approaches 200
injections), or the background noise in the electropherograms becomes repeated and excessive
(based upon the training and experience of the Forensic Scientists), the array shall be replaced.
Forensic Scientists shall notify the QCO and DNA Technical Leader if they observe any of the
above-mentioned scenarios.

5.1.4.1 If the array is replaced at the start of the week (i.e., coinciding with weekly maintenance),
the following procedure shall be followed:

5.1.4.1.1 At the 3130XL instrument, make sure the plate is unlinked. If a plate is linked,
click on the green plate position and then click “unlink.”

5.1.4.1.2 Restart the Collection software: at the computer under “service console,” single
click on “restart all.”

5.1.4.1.3 When all areas are green squares, the array change may proceed.

5.1.4.1.4 Microwave ~500 mL of purified water in a beaker on high for 2 minutes until
lukewarm and remove from microwave. Do NOT use boiling water.

5.1.4.1.5 Add at least 8 mL of purified water to the extra bottle labeled dH,O.

5.1.4.1.6 Atthe 3130XL, push the tray button and wait for the autosampler tray to come to
the front of the instrument. After the tray comes to a complete stop, make sure
the status light is a steady green and open the doors.

5.1.4.1.7 Remove the anode and cathode buffer reservoirs along with the water reservoirs.

5.1.4.1.8 Discard septa into the biohazard box.

5.1.4.1.9 Pour the contents of the reservoirs down the sink.

5.1.4.1.10 Place the anode buffer reservoir under the lower block.
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5.1.4.1.11 On the Foundation Data Collection Version 3.0 software, click on “Wizard.”
Highlight “Install Array Wizard” and follow the instructions on the software.

5.1.4.1.12 When the window appears, replace the water bottle with the polymer supply
bottle stop until the syringe fitting knob is washed.

5.1.4.1.13 Using a 24 mL syringe, place it in the water and draw up at least 10 mL of
lukewarm purified water.

5.1.4.1.14 Loosen the syringe fitting and waste fitting knobs.

5.1.4.1.15 Place the filled syringe in the loosened syringe fitting knob and place the anode
buffer reservoir under the waste fitting.

5.1.4.1.16 Push on syringe and dispense at least 10 mL of lukewarm purified water through
the syringe fitting. Do not overflow the anode buffer reservoir.

5.1.4.1.17 If bubbles are present in the water seal and/or water trap, re-fill the syringe and
push purified water through until no bubbles are present when the knobs are
tightened.

5.1.4.1.18 Tighten the syringe fitting and waste fitting knobs.

5.1.4.1.19 Continue to follow the instructions on “Install Array Wizard.” Click on the
“finish” button when it appears.

5.1.4.1.20 Place the anode and cathode buffer reservoirs and the two water reservoirs into
the purified water.

5.1.4.1.21 Agitate the opening and remove items from water (removing all crystals that
may have formed).

5.1.4.1.22 Place items on a wipe. Use an additional wipe to dry the anode and cathode
buffer reservoirs along with the two water reservoirs. Pour water down the sink.

5.1.4.1.23 Prepare 1X buffer (see 5.1.2.19).

5.1.4.1.24 Add 1 X buffer to the fill line of the anode and cathode buffer reservoirs and cap
with new septa. Add purified water to the fill lines of the water reservoirs and
cap with new septa.

5.1.4.1.25 Secure the septa on the cathode buffer reservoir along with the water reservoirs.
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5.1.4.1.26 At the 3130XL, push the tray button. Wait for the autosampler tray to come to
the front of the instrument and to a complete stop. Make sure the status light is a
steady green.

5.1.4.1.27 Open the instrument door and place the cathode buffer reservoir and water
reservoirs in their proper positions.

5.1.4.1.28 Secure the anode buffer reservoir onto the 3130XL.
5.1.4.1.29 Check for bubbles in the polymer supply tube, interconnect tube, and array port.

5.1.4.1.30 If there are bubbles, click on the Wizard File on the top of the Foundation Data
Collection Version 3.0 software. Then click on “Remove Bubbles Wizard” and
follow the instructions through the Wizard until no bubbles remain.

5.1.4.1.31 Once bubbles are no longer present, check to make sure there is polymer in the
polymer supply bottle.

5.1.4.1.32 If polymer needs to be added, remove the polymer supply bottle and add more
polymer from the refrigerator. Re-secure the polymer supply bottle back on the
instrument.

5.1.4.1.33 Once complete, close doors. Fill out the 3130XL Monthly Cleaning Schedule
chart with QCO initials, date, array use and maintenance performed. Any
polymer or array information (e.g., changing lot numbers) shall be documented
on the 3130XL Monthly Maintenance Form.

5.1.4.1.34 Perform a Spatial Calibration (see 5.1.7); a Spectral Calibration may be
performed (see 5.1.8).

5.1.4.2 If the array is replaced at any other point (e.g., not coinciding with weekly maintenance),
the following procedure shall be followed:

5.1.4.2.1 Push the tray button. Once the autosampler tray comes to the forward position
and comes to a complete rest, make sure the status lights on the instrument are a
steady green. Open the doors.

5.1.4.2.2 Click on the Wizard File on the top of the Foundation Data Collection Version
3.0 software that states “Update Cap Array Info” and follow the prompts.

5.1.4.2.3 Perform a Spatial Calibration (see 5.1.7); a Spectral Calibration may be performed
(see 5.1.8).

5.1.4.2.4 Note any polymer or array information on the 3130XL Monthly Maintenance
Form for that instrument.
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5.1.5 Service and/or Repair

5151

Repair: If a 3130XL becomes inoperable due to a need for repair by the manufacturer, the
QCO shall notify the Section via email as well as by placing a notice on the specific
instrument that is not available for use. The QCO shall also notify the DNA Technical
Leader and the manufacturer that repair is needed.

Performance QC Check: if a 3130XL instrument is removed from use due to repair, a post
maintenance QC check on the instrument shall be performed by the QCO prior to its return
to use in the Section.

5.1.5.2 Annual Preventative Maintenance: the ABI 3130XL Genetic Analyzers shall have

5.15.3

preventative maintenance performed annually by the manufacturer.

5.1.5.2.1 Refer to the Planned Maintenance Protocol (record) provided by the manufacturer
for specific calibrations, verifications, and tests performed during the annual
preventative maintenance.

5.1.5.2.2 Performance QC Check: After preventative maintenance, each 3130XL shall have
a post maintenance QC check performed by the QCO.

Argon-ion Laser Failure: the argon-ion laser inside the 3130XL instrument excites the dyes
attached to the DNA fragments in the capillaries. When the laser fails, no fluorescent data
is generated across all color channels.

5.1.5.3.1 If the argon-ion laser fails on a 3130XL instrument, the QCO shall proceed as
described in 5.1.5.1. Only the manufacturer (via field engineer) may replace the
laser.

5.1.5.3.2 Once the laser has been replaced, the QCO shall perform both spatial and spectral
calibrations (see 5.1.7 and 5.1.8) if not already performed by the manufacturer
during laser replacement.

5.1.5.3.3 The QCO shall then perform a Post Maintenance Performance QC Check on the
instrument (see 5.1.6).

5.1.5.3.4 Additionally, a sensitivity study shall be performed on the instrument by the QCO
at the direction of the DNA Technical Leader.

5.1.5.3.5 After all conditions set in 5.1.5.3.1 through 5.1.5.3.4 are satisfied, the DNA
Technical Leader shall release the instrument for use in Casework. The QCO
shall notify the Section by email and by placing a notice on the specific instrument
that it is available for use.

5.1.5.3.6 All documentation pertaining to a laser failure shall be retained as described in
5.1.5.4.

5.1.5.4 Documentation of any repair or annual preventative maintenance, as well as subsequent QC

Checks shall be retained in the Section indefinitely and shall be maintained by the QCO in
the binder associated with each specific instrument which shall be located near that specific
instrument.
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5.1.6 Post Maintenance Performance QC Check: Before any validated 3130XL shall be used by
Forensic Scientists in the Forensic Biology Section after repair or maintenance, a Performance QC
check shall be performed by the QCO as described below. When a 3130xI instrument is either
removed or returned to service, the QCO shall notify the Section via email and place a notice on the
instrument regarding its status. All QC documentation shall be retained in the appropriate QC files
with the specific 3130XL maintenance records. DNA TL approval shall be obtained prior to return
to service of any 3130XL.

5.1.6.1 Post Annual Preventative Maintenance: If no modifications to the optical components of
a 3130xI are made during annual performance maintenance (PM), the following instrument
assessments shall be performed:

5.1.6.1.1 Precision: A master mix of ladder/formamide/LIZ sizing standard shall be
prepared to fill a complete injection (16 wells or 2 columns) on a single plate and
injected at normalized conditions. The ladder shall be analyzed for precision such
that all alleles within the allelic ladder have standard deviations below 0.15 bp.
The 250-bp peak within the LI1Z sizing standard shall have a total range of sizes
less than +/- 0.5bp and a standard deviation of less than 0.15bp.

5.1.6.1.2 Normalization: Several samples of 9947A or NIST-TS (target 1 ng based upon
most recent QC results) shall be amplified and the PCR product pooled in order to
fill at least three complete injections (2 complete columns per injection, including
one well set aside for allelic ladder). Inject one set at normalized conditions
(injection time used prior to service) to establish normalization using the most
current data from other casework dedicated 3130XL instrument(s). Repeat
injection times on serviced instrument with different injection times as necessary
until this criterion is satisfied.

Note: Normalization shall also be performed as needed at the direction of the
DNA Technical Leader.

5.1.6.1.3 NIST Traceability: After precision and normalization have been successfully
achieved, at least one NIST-Traceable Standard (NIST-TS) (see Procedure for
DNA Reagent Preparation and Quality Control) shall be amplified (i.e.,
IdentifilerPlus™) with the appropriate amplification positive and negative
control(s) and injected on the serviced instrument. The NIST-TS, positive
amplification control and allelic ladder shall provide the expected allele calls at all
loci tested. All negative controls shall be free of alleles. Note: If no modifications
were made to the optical components of the 3130XL, only NIST Traceability shall
be performed.

5.1.6.1.4 Note: If any of the above assessments are not satisfied, the QCO may repeat the
assessment one additional time. If the assessment fails a second time, proceed to
5.1.6.2 or place a service call to the manufacturer as necessary.

5.1.6.2 After Repair/Post PM QC Failure: After any repair to the optics system of a 3130XL
(e.g., laser replacement), or if post annual maintenance QC fails, the following assessments
shall be performed:
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5.1.6.2.1 Precision, NIST-TS, and Normalization (see 5.1.6.1.1 thru 5.1.6.1.3).

5.1.6.2.2 Sensitivity: A dilution series of NIST-TS shall be prepared beginning with a total
initial input target of 2 ng and serially diluted to 0.031 ng, with an additional
0.100 ng dilution prepared. The serial dilutions shall be quantified in triplicate
and their concentrations adjusted accordingly (if necessary). The dilutions shall
then be amplified in triplicate and injected on the 3130XL at previously
established normalized conditions. All data within 90 to 390 bp shall be assessed
for minimum threshold (Limit of Detection, Limit of Quantification), peak height
imbalance (peak height ratios), and stochastic thresholds (allelic drop-out).
Thresholds and PHR shall fall within existing specifications. Note: Other well-
characterized DNA samples may be used as appropriate for this assessment.

5.1.7 Spatial Calibrations

5.1.7.1 Purpose: establish a relationship between the signal emitted by each capillary and the
position where that signal falls and is detected by the CCD camera.

5.1.7.2 A spatial calibration shall be performed when a capillary array is installed/replaced, an
instrument is moved, or when the capillary array is temporarily removed from the detection
block. The spatial shall be performed by the QCO.

5.1.7.3 In the Data Collection software, click “ga” instruments.

5.1.7.4 Select “ga3130” or “ga3130xl,” instrument name, and spatial run scheduler.

5.1.7.5 In the spatial protocol section, select one of the following: “3130SpatialNoFill 1” or
“3130SpatialFill_1.” (Note: It is not necessary to fill the capillaries each time a spatial

calibration is performed.)

5.1.7.6 Click start.
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Spatial Protocols

Protocol: jeiRelaieEi=| ] ]

Start

5.1.7.7 Evaluating a spatial calibration file
5.1.7.7.1 Ensure the following: peak heights are similar for all peaks, one orange cross
marking the top of every peak (no misplaced crosses), single sharp peaks for each
capillary are present with small shoulders, and the difference between adjacent
positions is 13 to 16 pixels (theoretical spacing between capillaries is 15).

5.1.7.7.2 Examine each row in the 16 capillary positions table and verify that the values in
both the left spacing and right spacing columns range from 13 to 16 pixels.

5.1.7.7.3 The spatial shall be accepted or rejected; if rejected, repeat the steps as prompted.

16 Capillary Positions

Capillary Position (pixels) Left spacing Right spacing

| 1 10 o 15 ~
2 25 15 16
3 41 16 15
4 o6 15 16
5 72 16 15
= av 15 15
7 102 15 15
g 117 15 15
9 132 15 16
10 145 16 15
11 163 15 15
12 175 13 16
13 194 16 15 W
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5.1.8 Spectral Calibrations

5.1.8.1 Spectral calibration creates a matrix that is used during a run to reduce raw data from the
instrument to the 4-dye or 5-dye data stored in sample files.

5.1.8.2 A spectral calibration shall be performed if any of the following conditions occur: new dye
set is used, the capillary array length or polymer type for fragment analysis is changed,
after the laser or CCD camera has been realigned/replaced by the service engineer, or if a
decrease in spectral separation is seen (pull up and/or pull down peaks become excessive)
in the raw or analyzed data.. Note: a previously run and accepted spectral or a spectral
from another instrument can be imported and used.

5.1.8.3 Remove matrix kit from the refrigerator (4 °C) and vortex.
5.1.8.4 Remove two aliquots of formamide from the freezer (-20 °C) and allow to thaw.

5.1.8.5 Add 5 pL of the matrix standard to 195 uL of Hi_Di formamide (matrix standard amount
may be increased or decreased based on the spectral results).

5.1.8.6 Vortex and spin briefly in a microcentrifuge.

5.1.8.7 Using a 96 well plate in columns 1 and 2 and rows A-H, add 10 pL of the
matrix/formamide mixture to each well.

5.1.8.8 Cover plate with a 96 well plate septa and spin in a centrifuge for ~ 1-2 minutes @ 2000
rpm.

5.1.8.9 Remove from centrifuge and place on a thermal cycler. Denature the plate on the thermal
cycler.
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5.1.8.10 Assemble the plate for electrophoresis (plate base, 96 well plate, plate retainer) and press
the tray button on the 3130XL to move the autosampler tray forward. Once the light stays
a constant green, open the doors and place the plate on the instrument and close the doors.

5.1.8.11 Under Data Collection software, “ga instrument,” “ga3130x1,” protocol manager, click
“new” under the instrument protocols pane and the protocol editor dialog box opens.

5.1.8.12 Complete the protocol editor dialog box (name, type: spectral, dye set, select polymer,
array length, chemistry file, run module). Then click “ok.” (Note: chemistry file for
fragment analysis dye set defaults to the matrix standard and modules list is filtered
based on the polymer type and array length.)

5.1.8.13 Under the “Data Collection software,” “ga instruments,” “ga3130x1,” “plate manager,”
click “new.”

5.1.8.14 Complete the new plate dialog box by entering the “plate name,” “application,” “plate
type,” “owner” (SBI), and “operator name.” Click “ok.”

5.1.8.15 The spectral calibration plate editor appears.
5.1.8.16 In “sample name” type in matrix and under “instrument protocol 1,” select spectral.
5.1.8.17 Once the entire 2 rows are filled, click “ok.”

5.1.8.18 Under “ga instrument,” “ga3130x1,” “instrument name,” “run scheduler,” click “plate
view.”

5.1.8.19 Change search type to advanced, “plate status” select “=,” change “value 1” to “pending”
and click “search.”

5.1.8.20 Select the record to “run,” click the plate position indicator that matches the plate to link,
and click the green arrow to begin. When asked: you are about to start processing plates,
click “ok.”

5.1.8.21 Viewing the pass/fail status after the run:
5.1.8.21.1 Select “ga instrument”, “ga3130xL” “instrument name,” “instrument status,”
“event log.”

5.1.8.21.2 In the event message section of the window, view the status of each capillary.
Each capillary should have a Q-value above 0.95 (if spectral calibration failed,
see troubleshooting and reference guide).

5.1.8.21.3 Under the data collection software, click “ga instruments,” “ga3130xl,”

“instrument name,” “spectral viewer.”
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5.1.8.21.4 In the dye set drop-down list, select the dye set.

5.1.8.21.5 In the plate diagram, select a well on the plate diagram to view the capillary
spectral results (Note: a failing capillary is automatically assigned the spectral
profile of its nearest passing capillary).

5.1.8.21.6 Evaluate the spectral profile and raw data for the selected capillary: verify that
the order of the peaks in the spectral profile for Intensity vs. Pixel Number
(from left to right) is blue, green, yellow, and red followed by orange for 5-
dye chemistry.

5.1.8.21.7 Verify that the order of the peaks in the raw data profile for Intensity vs. Scan
Number (from left to right) is orange, red, yellow, green, and blue.

5.1.8.21.8 Verify that the peaks in the spectral profile do not contain gross overlaps,
dips, or other irregularities.

5.1.8.21.9 Repeat for each capillary in the array.
5.1.8.22 Setting an active spectral calibration:

5.1.8.22.1 In the data collection software click, “ga instrument,” “ga3130xl,”

29 G

“instrument name,” “spectral viewer.”
5.1.8.22.2 In the dye set drop-down list, select a dye set.

5.1.8.22.3 Select the spectral calibration to use from the dye set drop-down list.

5.1.8.22.4 If the spectral calibration is acceptable, then click “set.” Otherwise run a new
spectral calibration.
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5.1.9 Clearing Errors

5.1.9.1 If the instrument status light is flashing red or the software System Status is flashing
red, the error must be cleared before any further analysis can be completed. The QCO
shall evaluate the situation and perform the following steps once notified by a
Forensic Scientist that an error is present.

5.1.9.2 To clear the error on the software, open the Foundation Data Collection Version 3.0
(data collection software), under the instrument’s name there is a “+” to the left of

“Instrument Status.”

5.1.9.3 Click the “+” to the left of “Instrument Status” and another drop down menu appears
on the screen.

5.1.9.4 Click on “Event Log.”
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“Clear Errors” changes the System Status from red to green.

right that states “Clear Errors.”

5.1.9.6 If the software System Status does not change back to a green arrow, or if the

instrument status light does not stop flashing red, Power Off/On the Instrument (refer
to the Forensic Biology Section Procedure for Use of the 3130XL Genetic Analyzer).

5.2 ABI 7500 Real-Time PCR System Instrument Maintenance

5.2.1 The following table displays the recommended 7500 instrument and laptop maintenance

the frequencies indicated by the table.

schedule ensuring proper operation of the instrument.
annual maintenance tasks should be performed using the listed steps/reference information at
All tasks except for annual maintenance shall be
performed under the direction of the QCO and all records shall be maintained in the section.
Monthly maintenance tasks are already included in months during which semi-annual or annual
maintenance is performed.

Monthly, quarterly, semi-annual, and

Frequency Maintenance Task See Step: Reference*
Monthly check lamp status 116
replace lamp if needed 121-123
(NOTE: lamp replacement must be followed by ROI
calibration/optical calibration/dye calibration—steps/references are
noted in semi-annual task list of this maintenance table)
decontaminate block 117-120
background calibration 77-85, 88
reboot laptop and wipe surface of 7500 with lint-free cloth
Quarterly disk cleanup/defragment disks
Semi- check lamp status (replace if needed) 116
annually decontaminate block 117-120
(in order as ROI calibration** 65-75
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listed) background calibration 77-85, 88
optical calibration** 86-87
dye calibration: VIC, FAM, ROX, NED (Quantifiler Duo)** 89-102
Instrument verification (either RNase P or QC check) 523 103-112
reboot laptop and wipe surface of 7500 with lint-free cloth, back-
up of .eds files
Annually  Performed by AB technician; includes all semi-annual procedures
As needed decontaminate block 117-120
Laptop hard drive — run disc clean-up and defragmentation 64
check lamp status 116
replace lamp if needed 121-123
(NOTE: lamp replacement must be followed by ROI
calibration/optical calibration/dye calibration—steps/references
are noted in semi-annual task list of this maintenance table)
replace 7500 fuses 124-125
RNase P verification 103-112
(NOTE: RNase P verification is typically only performed at
the request of AB Technical Support for troubleshooting
purposes)
Monitor the 7500 System 114-115
update windows operating system call AB
update 7500 software call AB

*  Reference page numbers refer to the "Applied Biosystems 7500/7500 Fast Real-Time PCR Systems
Installation and Maintenance Guide" (PN# 4387777 Revision D) found in Attachment A

** The ROI calibration plate is used to perform both ROl and Optical calibration procedures. This plate, as well as
the Quantifiler Duo dye calibration plates, can be used to calibrate up to three instruments and must be stored
frozen, although they can remain at room temperature up to 8 hours between calibrations if protected from light

exposure.

5.2.2 Repair: If an ABI 7500 becomes inoperable due to a need for repair by the manufacturer, the QCO

shall immediately notify the DNA Technical Leader and manufacturer. Additionally, the QCO
shall notify all members of the Forensic Biology Section via email and place a notice on the
specific instrument that it is not available for use.

5.2.3 Post Annual Maintenance/Repair Performance QC Check: Before any validated ABI 7500 may be

used for analysis following repair or annual preventive maintenance, a QC check shall be
performed by the QCO. This QC check shall be performed as follows:

5.2.3.1 A NIST-TS (see DNA Reagent Preparation and Quality Control Procedure) shall be
guantitated (i.e., Quantifiler Duo) with the DNA Standard Curve in duplicate (16 total data
points) and a Negative Template Control (NTC).

5.2.3.2 Items listed above shall be quantitated in accordance with the Procedure for DNA
Quantitation.
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5.2.3.3 The NIST-TS shall indicate the presence of DNA. All testing negatives shall have an IPC
C, value of > 36 or a value stating it is “Undetermined.”

5.2.3.4 Quality metrics of the standard curves (both human and male) shall fall within acceptable
QC ranges.

5.2.3.5 If either 5.2.3.3 or 5.2.3.4 is not satisfied, the QCO shall repeat the QC check.

5.2.3.6 The QCO shall notify the Section via email as well as by placing a notice on the specific
instrument that it is again available for use once the QC check is completed.

5.2.3.7 The QCO shall document the testing performed and retain them in the appropriate QC files
with the specific ABI 7500 maintenance records until it is scanned into the Section shared
folder.

5.3 ABI 9700 Thermal Cyclers

5.3.1 Internal Quarterly Verification: All thermal cyclers currently in service within the Section shall
be subjected to a series of temperature verifications on a quarterly basis by the QCO. Gloves, masks
and lab coats shall be worn at all times. Caution shall be exercised at all times as the thermal
cyclers can reach temperatures in excess of 100 °C. Documentation of all verifications shall be
noted on the Thermal Cycler Verification Record by the QCO performing the verification for each
thermal cycler. This documentation shall be retained indefinitely by the QCO.

5.3.1.1 Temperature Uniformity: A set of twelve wells on each thermal cycler shall be tested for
two temperature groups: 95 °C and 40 °C. For each temperature group, the range between
the highest and lowest values shall not exceed +/- 1 °C. Additionally, each individual well,
for each individual temperature, shall not deviate +/- 1 °C from the set temperature.

5.3.1.1.1 Turn on the thermal cycler, select “run” and “TNU” (or “Temp Uniformity”).
Select a 25 pL reaction volume. Select “start.”

5.3.1.1.2 When the thermal cycler reaches 95 °C as indicated on the display, select the
“pause” button. Insert the digital Eutechnics 4500 probe (or equivalent) into the
appropriate well (listed below) and shut the lid. Do not pinch the cord. Tested
wells are as follows: Al, A6, Al2, C4, C9, D7, E3, F2, F11, H1, H7, and H12.

5.3.1.1.3 Allow the probe to stabilize (may take a few minutes). Record the temperature to
the nearest tenth of a degree for that well as indicated by the probe. Proceed to the
next well until all twelve wells have been recorded on the Thermal Cycler
Verification Record (TCVR) for the 95 °C temperature range. Note: QCO or
designee may have to continue selecting the “pause” mode to complete this step so
as to keep the thermal cycler at 95 °C.

5.3.1.1.4 Select the “resume” button on the display or allow the “pause” mode to time out.
The thermal cycler begins to cool down to 40 °C. Using the same wells as listed
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in 5.3.1.1.2, test and record the 40 °C temperature results as described in 5.3.1.1.2
and 5.3.1.1.3. Record the temperature for each well on the TCVR.

5.3.1.1.5 Calculate the range in temperature from 5.3.1.1.3 to 5.3.1.1.4. These values shall
not exceed +/-1 °C from the set temperature or from each other (compare highest
recorded temperature for each range to the lowest recorded temperature for each
range). Record the results on the TCVR.

5.3.1.1.6 If the calculated values exceed the criteria described in 5.3.1.1, the QCO shall
notify the DNA Technical Leader and the thermal cycler in question shall be
removed from service. The QCO shall notify the Section via email, as well as by
placing a “Do Not Use” sticker on the thermal cycler.

5.3.1.2 Heat and Cool Rate Test: the ability of the thermal cycler to heat and cool the block
quickly is determined by the following steps:

5.3.1.2.1 Turn on the thermal cycler, select “Utilities,” “Diag,” “System,” and “Rate.”

5.3.1.2.2 The thermal cycler displays a warning. At this time, place an empty 3130XL 96-
well tray, with septa, onto the thermal cycler, and close the lid. Select “Cont.”

5.3.1.2.3 The thermal cycler runs the program. When the program is completed, the
display indicates “pass” or “fail.” It also provides the rate at which the thermal
cycler both heats and cools. Rates, as well as “pass” or “fail,” shall be recorded
on the TCVR.

5.3.1.2.4 If a “fail” result is obtained, the QCO may retest the thermal cycler once more. If
the particular thermal cycler indicates a second “fail,” the QCO shall notify the
DNA Technical Leader and the thermal cycler in question shall be removed from
service. The QCO shall notify the Section via email, as well as by placing a “Do
Not Use” sticker on the thermal cycler.

5.3.1.3 Temperature Verification: the digital probe is used to verify that the thermal cycler is
producing a temperature within +/- 1 °C of the set temperature.

5.3.1.3.1 In the display window, select “Utilities,” “Diag,” “TempVer.”

5.3.1.3.2 Place the digital probe into well A6 and close the lid. Do not pinch the cord.
Select “Run.”

5.3.1.3.3 The thermal cycler ramps up to 85 °C and prompt the user when complete. At this
point, the QCO records the temperature on the digital probe on the TVCR and
enter that value as prompted into the thermal cycler to the nearest tenth of a
degree.

5.3.1.3.4 Continue the test by allowing the thermal cycler to ramp down to 45 °C
(“stabilizing at setpoint”) and record the resulting information as described in
5.3.1.3.3. Select “accept” once both the 85 °C and 45 °C values are entered into
the display window.
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5.3.2 Notification for Use: If any thermal cycler fails any of the three tests, the QCO shall immediately
notify the DNA Technical Leader, as well as the Section via email and a “Do Not Use” sticker shall
be placed on the affected instrument.

5.3.3 Performance QC Check: if a thermal cycler requires a QC check after repair, for validation, or
before a new instrument is put on-line, a QC check shall be performed by the QCO, in addition to
the three tests as described in 5.3.1.

5.3.3.1 This QC check shall consist of the amplification of the following as a set

5.3.3.1.1 Positive amplification control (9947A) and negative amplification control (Neg
Amp), using the current amplification Kit.

5.3.3.1.2 NIST-TS.

5.3.3.2 Five total sets shall be amplified at the following well locations and electrophoresed and
analyzed per DNA procedures:

5.3.3.2.1 E1-H1, C4-F4, B7-E7, E10-H10, A12-D12

5.3.3.3 The expected results for the NIST-TS, positive amplification controls, and allelic ladders
shall be obtained for all loci and the alleles shall be balanced within and between loci and
peak heights generally between 1000 and 6000 RFU's. All negative controls shall be free
of any peaks or activity. If any of these conditions are not met (for reasons other than
instrument failure, known artifacts), then the QCO may retest the affected wells in the
thermal cyclers once. If the conditions are not met this second time, the QCO shall keep the
thermal cycler offline and notify the DNA Technical Leader and manufacturer. If the
thermal cycler is under a manufacturer warranty, the manufacturer shall be contacted for
repair. If the thermal cycler is no longer under any warranty, it shall be placed in storage for
eventual surplus.

5.3.4 External Calibrations/Verification: if the thermal cyclers are verified by an external vendor, the
results shall be documented. The thermal cyclers that are passed by the external vendor shall be
accepted as calibrated/verified and noted as such until the next quarterly verification is due. This
documentation shall be retained indefinitely by the QCO.

5.4 Digital Probes

5.4.1 Annual External Calibration: the digital probes (Eutechnics 4500 or equivalent) shall be calibrated
annually by a contract vendor against an appropriate NIST traceable standard.

5.5 Bulb Thermometers

5.5.1 Purpose/Use: used to measure temperatures in incubators. Surplus calibrated bulb thermometers
shall be retained by the QCO, unless broken and then they shall be disposed of in accordance with
the Procedure for Section Safety.

5.5.2 Annual Internal Performance Check: all bulb thermometers in use within the Forensic Biology
Section shall be checked on an annual basis internally against a NIST traceable thermometer (i.e.,
the “NIST lollipop”) in an ice bath.
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5.5.2.1 Freeze several trays of dH,O into ice cubes; once frozen, grind or crush them in an ice
shaver (or equivalent). Mix the ice shavings with dH,O and place into an insulated
container deep enough (thermos or equivalent) to contain the metal probe portion of the
NIST Traceable Thermometer.

5.5.2.2 The QCO shall wipe down each bulb thermometer with fresh 10 % bleach followed by an
ethanol rinse and allow it to dry (either through evaporation or wiping with a wipe) before
inserting it into the ice bath.

5.5.2.3 Using clamps and foam (or equivalent) to hold both the NIST traceable thermometer and the
bulb thermometer to be calibrated within an inch of each other in the ice bath, wait for the
NIST traceable thermometer to register 0.0 °C. Be sure to align the bulb thermometer such
that the bulb portion is submerged in the ice bath, but that the area marked for 0.0 °C can
be visualized by the QCO.

5.5.2.4 Once the NIST traceable thermometer reads 0.0 °C, record the temperature to the nearest
tenth of a degree on the bulb thermometer. If the bulb thermometer is greater than +/- 1 °C
from the NIST traceable thermometer, it shall be destroyed and replaced with a calibrated
bulb thermometer.

5.5.25The QCO shall record both the NIST traceable thermometer and calibrated bulb
thermometer readings on the Bulb Thermometer Temperature Performance Check Form.
The QCO shall also create and place a sticker on each calibrated bulb thermometer that
indicates the specific bulb thermometer number, the date the next performance check is
due, the initials of the QCO performing the check, and whether the user of the bulb
thermometer shall add or subtract tenths of a degree to the reading of that bulb thermometer
to bring it to specifications as indicated by the NIST traceable thermometer (i.e., if the bulb
thermometer reads 0.5 °C higher than the NIST traceable thermometer, the Forensic
Scientist shall subtract 0.5 °C from the bulb thermometer reading before recording a
temperature).

5.5.2.6 This process shall be completed for all bulb thermometers, including those set aside for
storage or future use (i.e., replacement).

5.5.2.7 Documentation of the performance checks shall be retained indefinitely by the QCO in the
Section.

5.6 Digital Thermometers: Purchased from external vendor; shall be NIST traceable and replaced when
NIST traceability expires. Digital thermometers shall be used to monitor temperatures on freezers and
refrigerators in the Section as needed. Surplus digital thermometers shall be retained by the QCO.

5.7 NIST Traceable Thermometer (i.c., the “NIST lollipop”): Has an elongated metal probe which is used
for testing against bulb thermometers purchased from an external vendor; shall be NIST traceable and
replaced when NIST traceability expires.

5.8 Balances

5.8.1 Monthly Verification Check: Using a NIST traceable weight set, all balances in the Forensic
Biology Section shall be verified monthly by the QCO with the following weights and limits:
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5.8.1.1 Weight #1: 1 gram; Limit: 0.90 gram to 1.10 grams.
5.8.1.2 Weight #2: 25 grams; Limit: 24.90 grams to 25.10 grams.
5.8.1.3 Weight #3: 100 grams; Limit: 99.90 grams to 100.10 grams.

5.8.1.4 If any tested weight falls above or below the established limit criteria listed above, the QCO
shall immediately notify the DNA Technical Leader and the balance shall be removed from
service until repaired and calibrated by an external vendor.

5.8.1.5 The performance checks shall be recorded to at least the nearest hundredth of a gram by the
QCO or designee on the Monthly Balance Verification Form.

5.8.2 External Calibrations: All balances in the Forensic Biology Section shall be calibrated at least
annually by a contract vendor. The weight set in the Forensic Biology Section shall be calibrated
annually.

5.9 Pipettors

5.9.1 Annual External Calibrations: all pipettors in the Forensic Biology Section shall be calibrated at
least annually by a contract vendor.

5.9.2 Repair: if a pipettor breaks or a Forensic Scientist based on their training and experience believes
that the pipettor does not work properly, it shall be given to the QCO for storage until an external
calibration vendor can repair and calibrate it. If the pipettor is not repairable, it shall be removed
from the Section.

5.10 Temperature Data Loggers

5.10.1 Used to monitor temperature in post amplification rooms where 3130XLs (or equivalent) are
currently in use.

5.10.2 Data Loggers (USB)

5.10.2.1 Annual External Calibrations: All data loggers in the Forensic Biology Section shall
be calibrated annually by a contract vendor.

5.10.2.2 Retention of Data: The data loggers shall be set to record data every five minutes. The
data shall be printed by the QCO every month (to coincide with monthly 3130XL
maintenance) and retained indefinitely in the Section by the QCO. The data shall
include the date range captured by the logger as well as the serial humber of the
logger. Once monthly data is captured and retained, the data logger shall be cleared to
record data for the next month.

5.10.3 Retention of data: the paper temperature discs shall be changed weekly when in use by the QCO.
The circular discs shall be scanned into digital images. Both the original disc and the digital
image shall be retained indefinitely by the QCO in the Section.

5.11 Centrifuges
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5.11.1 Annual Preventative Maintenance: the Beckman-Coulter Allegra X-12R and X-12 centrifuges
shall have annual preventative maintenance performed by the manufacturer. The manufacturer
shall place a maintenance sticker on the centrifuge documenting that the service was performed.

5.11.2 Repair: If repairs are necessary, the manufacturer shall be notified by the QCO and an “out of
use” sticker placed on the affected centrifuge notifying the Section of its unavailability. Once the
affected centrifuge is repaired, the QCO shall remove the “out of use” sticker.

5.12 Biosafety Cabinets/Chemical Fume Hoods/Laminar Flow Clean Air Benches

5.12.1 Annual External Calibrations: all Nuaire Biological Safety Cabinets, Chemical Fume Hoods, and
Laminar Flow Clean Air Benches (amplification hoods) in the Section shall be calibrated
annually by a contract vendor.

5.12.2 Any hood listed in 5.12.1 that does not pass certification shall not be used.
5.13 Freezers/Refrigerators

5.13.1 Recording Temperatures: The QCO shall record high and low temperatures for all common area
refrigerators/freezers in the Section weekly; however, if the QCO has not yet recorded the
temperature and a Forensic Scientist uses a common area refrigerator/freezer, the Forensic
Scientist shall record the temperatures prior to opening the door(s). Temperatures are recorded on
a Temperature Recording Form (TRF).

5.13.2 -20 °C Freezers: These freezers shall not vary more than + 5 °C from the set temperature. The
temperature for these freezers shall be recorded by personnel using the TRF as described in
5.13.1.

5.13.2.1 The QCO shall fill out all required information regarding freezer serial number, the
location of the freezer, the set temperature of the freezer, and the associated digital
thermometer serial number at the beginning of every calendar year on a TRF for each
common area -20 °C freezer.

5.13.2.2 If at any point during the calendar year a new digital thermometer is needed, the QCO
shall write at the bottom of the TRF the date on which a new thermometer was used and
the serial number for the new thermometer.

5.13.2.3 If a -20 °C freezer must be thawed, the contents of the freezer shall immediately be
moved to another -20 °C freezer that is within range and the QCO shall note this, as
well as the affected dates, on the TRF. The contents shall not be returned to the original
-20 °C until the temperature is within range.

5.13.2.4 If the temperature for a -20 °C freezer exceeds the + 5 °C consistently for more than 5
consecutive business days, QCO shall immediately move the contents to another -20 °C
freezer that is within range and note this, as well as the affected dates, on the TRF. The
contents shall not be returned to the original -20 °C freezer until the temperature is
within range.
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5.13.3 -10 °C/4 °C Freezer/Refrigerator Units: These units shall not vary more than + 5 °C from the
set temperature(s) for the freezer portion; the refrigerator portion shall not fall below 0 °C or
exceed 9 °C. The temperature for these freezers shall be recorded using the TRF by personnel as
described in 5.13.1.

5.13.3.1 The QCO shall fill out all required information for common area -10 °C/4 °C
freezer/refrigerator units regarding the unit serial number, location, set temperatures, and
the associated digital thermometer serial number on the TRF. For limited access -10
°Cl4 °C freezer/refrigerator units, the Forensic Scientist(s) that have access to such units
shall fill out the information on a TRF.

5.13.3.2 If at any point during the calendar year a new digital thermometer is needed, the QCO
shall be notified and the new thermometer serial number shall be recorded on the TRF
associated with the refrigerator/freezer.

5.13.3.3 If the QCO or Forensic Scientist observes temperatures out of the range specified in
5.13.3 for more than five consecutive business days, then the QCO (for common area
units) or the Forensic Scientist (limited access units), shall attempt to adjust the
temperature back in range using the thermostat for the unit. If the temperature does not
come within range within an 24 hour period, the QCO (or Forensic Scientist) shall
transfer the contents of the unit to another unit with the same temperature parameters
and note on the TRF the unit to which the contents were transferred and the date of
transfer. If additional adjustments of the thermostat are unsuccessful, the unit shall be
removed from service and clearly marked as being out of service. If additional
adjustments are successful at restoring the unit to the temperatures specified in 5.13.3,
then the contents may be returned to the unit.

5.13.4 -70 °C Baxter Scientific Cryo-Fridge/-39 °C Revco Cryo-Fridge: These units shall not vary
more than + 10 °C from the set temperatures. The temperatures for the freezers shall be recorded
using the TRF by personnel as described in 5.13.1.

5.13.4.1 The QCO shall fill out all required information regarding freezer serial number, the
location of the freezer, the set temperature of the freezer, and the associated digital
thermometer serial number at the beginning of every calendar year on a TRF for each
freezer.

5.13.4.2 If any cryo-fridge deviates consistently + 10 °C from the set temperature for more than 5
consecutive business days, the QCO shall be notified, the contents of the affected cryo-
fridge removed and stored in an equivalent location, and the cryo-fridge manufacturer
(or current contract vendor) notified for repair. All information regarding cessation of
use and relocation of contents shall be documented on the TRF.

5.14 Incubators: temperatures shall be recorded on the day(s) the incubator is in use. If the incubator is in a
common area, the QCO shall record the temperature. If the incubator is in a shared suite, the Forensic
Scientist shall record the temperature. Temperatures shall be recorded on a TRF specific for the
incubator.
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5.14.1 The QCO or Forensic Scientist shall fill out all required information regarding the unit serial
number, location, set temperatures, and the associated bulb thermometer number on the TRF.

5.14.2 If the incubator is not used, the QCO or Forensic Scientist shall strike through the box which
corresponds to the day(s) not in use.

5.14.3 The incubators shall be +/- 5 °C degrees within the set temperature. If an incubator consistently
deviates more than this over a period of five consecutive readings, then the QCO or Forensic
Scientist shall attempt to adjust the temperature back into the acceptable range over a period of 24
hours. If all attempts at obtaining a set temperature within range fail, the QCO shall be notified
and the incubator removed from service and marked as such.

5.15 All verification, calibration, maintenance, and QC documentation shall be retained in the Forensic
Biology Section.

5.16 When any of the following instruments/equipment need repair and are taken out of use from the Section,
the QCO shall notify the DNA Technical Leader, and if necessary, the manufacturer. The QCO shall

also notify the DNA Technical Leader when the instruments/equipment are suitable for use by the
Section.

o 3130XL, ABI 7500, ABI 9700, QIAgility, EZ1 Advanced XL BioRobot, Centrifuges, Hoods,
Freezers/Refrigerators, Balances.

5.17 QlAgility
5.17.1 Annual Preventative Maintenance

5.17.1.1 Annual Preventative Maintenance: the QIAgility shall have preventative maintenance
performed annually by the manufacturer.

5.17.1.1.1 Refer to the Planned Maintenance Protocol (record) provided by the
manufacturer for specific calibrations, verifications, and tests performed
during the annual preventative maintenance.

5.17.1.1.2 Performance QC Check: After preventative maintenance, each QIAgility

shall have a post maintenance QC check performed by the QCO.
5.17.2 Weekly Maintenance

5.17.2.1 Wipe the outside of the instrument with a dust cloth or lab wipe dampened with
deionized water.

5.17.2.2 Remove all loading blocks and the tip ejector chute from the worktable. Rinse these
with ethanol and dry.

5.17.2.3 Wipe the worktable down with ethanol and return the tip ejector chute to the worktable.
Note: The tip ejector must be re-calibrated each time it is removed and replaced.

5.17.2.3.1 In the menu bar, click Options and then click Setup tip ejector. Click “Yes.”
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5.17.2.3.2 Follow the prompts to calibrate the ejector. Click “Locate Ejector” then
click “Yes.”

5.17.2.3.3 A box will appear asking “Is the pipettor hub above the slot of the ejector?”
Verify that the hub is located correctly and click “Yes.”

5.17.2.3.4 Click Finished and then click “OK.”

5.17.2.4 Close the lid and turn on the UV lamp. Click the light bulb on the icon bar at the top
of the screen. Click the box marked “Close software when UV finished?” and set the
time to 15 minutes.

5.17.2.5 Click Start and then click “Yes” when the alert screen opens.

5.17.2.6 Document the maintenance on the Forensic Biology Section QIAgility Maintenance
Form (located with the instrument).

5.17.2.6.1 The QCO shall retain such information in the QC files with the specific
instrument maintenance records.

5.17.3 Post Maintenance Performance QC Check: Before any validated QIAgility may be used by a
Forensic Scientist after repair or maintenance, a Performance QC check shall be performed as
follows:

5.17.3.1 A NIST-Traceable Standard (NIST-TS) and associated Neg K (see Procedure for DNA
Reagent Preparation and Quality Control) shall be quantified/amplified/setup for
capillary electrophoresis and run to the extent which the QIAgility has been validated .

5.17.3.2 Items listed in 5.17.2.1 shall be electrophoresed on the 3130XL at the normalized
injection protocol.

5.17.3.3 For quant setup, the NIST-TS shall indicate the presence of DNA. All negative controls
(e.g., NIST, Neg K, NTC) shall have an IPC C; value of > 36 or a value stating it is
“Undetermined.” Quality metrics of the standard curves (both human and male) shall
fall within acceptable QC ranges.

5.17.3.4 The NIST-TS, positive amplification control(s) and allelic ladder shall provide the
expected allele calls at all the loci tested.

5.17.3.5 All negative controls (Neg K, amplification negative control(s)) shall be free of any
alleles.

5.17.3.6 If 5.17.2.3, 5.17.2.4, or 5.17.2.5 are not satisfied (for reasons other than instrument
failure, known artifacts), the QCO or designee may retest (re-electrophorese, re-
amplify, re-quantitate, or re-extract) the samples one more time. If the retest does not
pass, a service call for equipment maintenance shall be placed.
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5.17.3.7 If the instrument passes the QC check, the QCO shall notify the Section via email and
place a notice on the specific instrument that it is available for use.

5.17.3.8 The QCO shall document the testing performed and retain such information in the QC
files with the specific maintenance records.

5.18 EZ1 Advanced XL BioRobot
5.18.1 Annual Preventative Maintenance

5.18.1.1 Annual Preventative Maintenance: the EZ1Advanced XL BioRobots shall have
preventative maintenance performed annually by the manufacturer.

5.18.1.1.1 Refer to the Planned Maintenance Protocol (record) provided by the
manufacturer for specific calibrations, verifications, and tests
performed during the annual preventative maintenance

5.18.1.1.2 Performance QC Check: After preventative maintenance, each EZ1
shall have a post maintenance QC check performed by the QCO.

5.18.2 Cleaning/Maintenance — See the Section Procedure for DNA Extraction Using the EZ1
Advanced XL.

5.18.3 Post Maintenance Performance QC Check: Before any validated EZ1 may be used by a
Forensic Scientist after repair or maintenance, a Performance QC check shall be performed as
follows:

5.18.3.1 A NIST-TS and associated Neg K (see Procedure for DNA Reagent Preparation and
Quality Control) shall be extracted.

5.18.3.2 Items listed in 5.18.1.1 shall be quantified, amplified, and electrophoresed on the
3130XL following current Section procedures.

5.18.3.3 For quant setup, the NIST-TS shall indicate the presence of DNA. All negative
controls (e.g., NIST, Neg K, NTC) shall have an IPC C; value of > 36 or a value
stating it is “Undetermined.” Quality metrics of the standard curves (both human
and male) shall fall within acceptable QC ranges.

5.18.3.4 The NIST-TS, positive amplification control(s), and allelic ladder shall provide the
expected allele calls at all the loci tested.

5.18.3.5 All negative controls (Neg K, amplification negative control(s)) shall be free of any
alleles.

5.18.3.6 If either 5.18.1.3, 5.18.1.4, or 5.18.1.5 are not satisfied (for reasons other than
instrument failure, known artifacts), the QCO or designee may retest (re-
electrophorese, re-amplify, or re-quantify) the samples one more time. If the retest
does not pass, then a service call for equipment maintenance shall be placed.

5.18.3.7 If the instrument passes the QC check, the QCO shall notify the Section via email
and place a notice on the specific instrument that it is available for use.
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5.18.3.8 The QCO shall document the testing performed and retain such information in the
QC files with the specific maintenance records.

6.0 Limitations - As noted in 5.0.

7.0 Safety

7.1 Thermal cyclers can exceed temperatures of 100 °C; use with caution to avoid burns.

7.2 Gloves, masks, and lab coats shall be worn when performing any verifications, calibrations, or QC checks
described in Section 5.

7.3 If the ice shaver (or equivalent) used as described in 5.5 is not self-contained, safety glasses shall be worn
during operation.

7.4 Formamide is a known chemical hazard; it causes eye, skin and respiratory tract irritation. It is a possible
reproductive and birth defect hazard. Wear appropriate eyewear, masks, gloves and clothing when in use.

8.0 References

Forensic Biology Section Procedure for Safety

Forensic Biology Section Procedure for Use of the 3130XL Genetic Analyzer for Casework
Forensic Biology Section Procedure for DNA Reagent Preparation and Quality Control
Forensic Biology Section Procedure for DNA Quantitation with Quantifiler® Duo

Forensic Biology Section Procedure for PCR Amplification for Casework

Forensic Biology Section Procedure for Aseptic Technigue and Contamination Control
Forensic Biology Section Procedure for DNA Extraction using the EZ1 Advanced XL
Instrument manuals

Applied Biosystems 3130/3130xI Genetic Analyzers. User Bulletin. 2005 Applied Biosystems. Part Number
4363787. Rev A. (or most recent revision)

Eutechnics 4500 Manual
NIST Special Publication 819

Applied Biosystems 7500/7500 Fast Real Time PCR Systems. Maintenance Guide. Part Number 4387777
Rev. D

9.0 Records

o Temperature logs for freezers, refrigerators (Daily and Weekly)
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Thermal Cycler Temperature Performance Check Forms

Bulb Thermometer Calibration Forms

Biosafety Cabinets/Chemical Fume Hoods/Lamina Flow Clean Air Benches Certificates

Certificates of Calibration for NIST Traceable Digital Thermometer, Digital Thermometers, Balances,

Pipettors, Digital Probes, Weights, and Temperature Chart Recorders/Data Loggers

e Manufacturer documentation of preventative maintenance and/or repair for 3130XLs, ABI 7500s, EZ1s,
QI Agilities, centrifuges

e EZ1 Cleaning/Maintenance Form

e QIAgility Maintenance Form

e 3130XL Monthly Maintenance Form

10.0 Attachments

A. Applied Biosystems 7500/7500 Fast Real Time PCR Maintenance Guide PN 4387777, Rev. D

Revision History

Effective Date Version Reason
Number
09/17/2012 1 Original Document
10/26/2012 2 Changed wording in 5.1.6.4 to remove requirement to note activity.
Added notification requirement to 5.2.1.
12/22/2013 3 Replaced Section 5.2 7000 Instrument maintenance with new 7500

maintenance; Removed 7000 references, added 7500 Maintenance
guide as reference; Changed 7000 to 7500 in definitions, equipment,
5.19, and records; 5.2.3 — removed requirement to place sticker on
instrument; Added 7500Maintenance Guide as Attachment A;
Removed diagram references

05/10/2013 4 5.2.1 - added wording to allow semi-annual/annual maintenance to
cover monthly maintenance; 5.3.3.1.1 — removed reference to
Identifiler Kkit; 5.3.3.2 — removed wording regarding injection
parameters (refer to section procedures)

09/25/2013 5 Header — added issuing authority titles; 3.0 — added EZ1 and QIAgility

to critical equipment list; 5.1.6 — changed performance check
requirement; 5.16.3.2 — changed wording to correspond with section
5.16.1; removed DNA Database analyst throughout document; 5.19 —
added EZ1 and QIAgility to list; 520 — inserted QIAgility
maintenance; 5.21 — inserted EZ1 maintenance; 8.0 — added EZ1
extraction procedure

12/18/2013 6 2.0, 5.15.35, 5.1.6 — removed database unit reference, changed
casework to Section; 3.0 — removed bead sterilizers and
BioRobot;5.1.6.1.2 added NIST-TS; 5.8, 5.14 — removed section; 5.12,
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5.16, 5.16, 5.18, 5.21 — updated section reference; 8.0 — updated
procedure references

03/07/2014 7 5.18.1.6 — added form to record maintenance; 5.19.1 — added cleaning
to section title; 9.0 - added EZ1 and QIAgility cleaning/maintenance
forms to records

04/18/2014 8 3.0 — removed heat blocks; 5.1.2.19.4 — added notation for buffer lot;
5.1.2.28, 5.1.4.2.4 — updated tracking to form from FA; 5.1.3.1 —
clarified when wash would be performed; 5.1.4.1.34, 5.1.4.2.3 — added
spectral calibration requirement; 5.1.6.1.2 — added note clarifying when
to perform; 5.1.6.1.3 — updated kit name; 5.1.8.2 — added requirement
to be done for array change also; 5.1.8.5 — updated formamide amount
and clarified note; 5.5.1 — updated use; 5.7 — removed bead sterilizers;
5.8.1.4 — removed “unless”; 5.8.1.5 — updated wording; 5.8.2 — added
weight calibrations; 5.10 — added Data loggers and recording
requirements; 5.13 — removed heat blocks section; 5.18.2.1 — clarified
extent of QC check; 9.0 — updated records

08/29/2014 9 5.1.4.1.33 — changed record information on form, not in FA; 5.1.4.1.34,
5.1.4.2.3 — changes to spectral may be performed; 5.1.6.1.3 — added
note for post maintenance check; 5.1.6.1.3, 5.2.3.1, 5.2.3.3, 5.3.3.1.2,
5.3.3.3 — removed requirement for Negative extraction control testing;
5.1.8.2 — removed requirement for spectral if array changed; 5.17.1,
5.18.1 — added annual preventative maintenance

02/27/2015 10 5.13.1, 5.13.3.2 — removed individual refrigerators, 5.13.1 - updated for
weekly recording of high and low temperatures
12/28/2015 11 3.0 — updated name; 5.1.3.1 — added transferring of data to monthly

maintenance for 3130; 5.2.1 — removed archive data from 7500; 5.2.3.7
— added wording about scanning records; 5.8.2and 5.9.1 — reworded to
at least annually; 5.10.2 and 5.10.4 — removed temp chart recorders

Page 37 of 148

All copies of this document are uncontrolled when printed.



Procedure for Calibration and Equipment Maintenance Version 11
Forensic Biology Section Effective Date: 12/28/2015

Issued by the Forensic Biology Forensic Scientist Manager and DNA Technical Leader

Attachment A:

Applied Biosystems 7500/7500 Fast Real Time PCR Maintenance Guide PN 4387777, Rev. D
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Preface

How to Use This Guide

Purpose of This The Applied Riosystems 7500/7500 Fast Real-Time PCR System (uide provides the
Guide information you need to maintain your Applied Biosystems T300/7500 Fast Real-Time
PCR System. This manual is designed to supplement the:

« Applied Biosystems 73007500 Fast Real-Time PCR System Site Preparation Guide
+ Applied Biosystems 7300/7500 Fast Real-Time PCR System Computer Setup Guide

Audience  This guide is intended for novice and experienced 7300/7500 Fast system users who
need to maintain their system.

Assumptions  This guide assumes that your 7500/7500 Fast system has been installed by an
Applied Biosystems technical representative and that you:

« Are familiar with the Microsoft® Windows® operating system.
* Understand general techniques for preparing and handling DINA samples.

* Have a general understanding of hard drives and data storage, file transfers, and
copying and pasting.

Text Conventions This guide uses the following conventions:
* Bold text indicates user action. For example:
Type 0, then press Enter for each of the remaining fields.

+ [talic text indicates new or important words and is also used for emphasis.
For example:

Before analyzing, always prepare fresh matrix.

» A right arrow symbaol { b ) separates successive commands you select from a
drop-down or shortcut menu. For example:
Select File » Open ¥ Spot Set.

Right-click the sample row, then select View Filter » View All Runs.

User Attention  Two user attention words appear in Applied Biosystems user documentation. Each word
Words  implies a particular level of observation or action as described below:

Note: — Provides information that may be of interest or help but is not critical to the use
of the product.

IMPORTANT! — Provides information that is necessary for proper instrument operation,
accurate chemistry kit use, or safe use of a chemical.

Applied Biosystems 75007500 Fast Real-Time PCR System Maintenance Guide vii
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Prefaca
How to Obstain More Information

Examples of the user attention words appear below:

Mote: The Calibrate function is also available in the Control Console.

IMPORTANT! To verify your client connection to the database, you need a valid user 1D
and password.

Safety Alert
Words

Safety alert words also appear in user documentation. For more information, see “Safety
Alert Words™ on page xii.

How to Obtain More Information

Related The following related documents are shipped with the 7500/7500 Fast system:

Documentation

Guide Purpose and Audience PN
Applisd Biosystems 7500/7500 Fast Explains how to parform expariments on the 75007500 Fast 4387784
Real-Time PCR System Getting Started systam. Each Gatting Started Guide functions as both:
Guide for Genatyping Experiments + Tutorial, using example experiment data providad with the
: : lied Biosystems 7500/7500 Fast Real-Time PCH
Appliad Biosystems 7500/7500 Fast Applie 4387785
FAesal-Time PCR System Getting Starfed Softwara (7500 Softwars).
Guide for Prasence/Absence Experiments | * Guide for your own experiments.
- . Intandad for laboratory staff and principal investigators who
Applisd Biosystems 7500/7500 Fast - : 4387783
Feal-Time PCR System Getting Started perform experimeants using the 7500/7500 Fast system.
Guide for Relative Standard Curve and
Comparafive G Expariments
Applied Bigsystems 7500/7500 Fast 4387779
Reai-Time PCR Sysfem Gatting Sfarted
Guide for Standard Curve Experiments
Applisd Biosystems ?Eaﬂf?_ﬁaﬂ Fast Explains how to install and maintain the 7500/7500 Fast system. | 4387777
gﬁggrm PCR System Maintanance Intendsad for laboratory staff responsible for the installation and
maintanance of the 7500/7500 Fast systam.
Applied Biosystems 7500/7500 Fast 4387778
Reai-Time PCR Sysfam Computar Seiup
Guide
Applisd Biosystems 7500/7500 Fast Provides information about the reagents you can use on tha 4387787
Raai-Time PCR System Raagent Guide 75007500 Fast systam, including:
+ Anintroduction to TaghMar® and SYBER® Grean reagants
+ Dazscriptions and dasign guidalines for tha following
expariment typas:
- Quantitation exparimeants
- Genotyping expariments
- Presance’zbsance experments
Intended for laboratory staff and principal investigators who
perform experiments using the 7500/7500 Fast systam.

wili
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Guide

Purpose and Audience PN

Guide

Applied Biosystems 7500/7500 Fast Explains how to prapare your site to receive and install the 4387776
Real-Time PCR System Site Praparation 7500/7500 Fast system.

Intandad for personnel who schedule, manage, and perform the
tasks raquired to prepare your site for installation of the
7500/7500 Fast system.

Applied Biosystems 7500/7500 Fast Explains how to use the 7500 Software to: NA
Real-Time PCR Software v2.0 Help

¢ Sat up, run, and analyze experimants using the 7500/7500
Fast system.

* Monitor a networked 7500/7500 Fast instrument.

¢ (Calibrate a 7500/7500 Fast instrument.

* \erify the performance of a 7500/7500 Fast instrument with
an RNase P run.

Intended for:

¢ Laboratory staff and principal invastigators who perform
experiments using the 7500/7500 Fast system.

¢ Laboratory staff responsible for the installation and
maintenance of the 7500/7500 Fast system.

Obtaining
Information from
the Help System

Send Us Your
Comments

Note: To open the user documentation included on the Documentation CD, use the
Adobe® Acrobat® Reader® software available from www.adobe.com.

Note: For additional documentation, see “How to Obtain Support” on page x.

The 7500 software has a Help system that describes how to use each feature of the user
interface. Access the Help system by doing one of the following:

*» Click @ in the toolbar of the 7500 software window
+ Select Help » 7500 Software Help
* Press F1
You can use the Help system to find topics of interest by:
* Reviewing the table of contents
*» Searching for a specific topic
*» Searching an alphabetized index
You can also access PDF versions of all documents in the Applied Biosystems
7500/7500 Fast Real-Time PCR System document set from the Help system.
Applied Biosystems welcomes your comments and suggestions for improving its user

documents. You can e-mail your comments to:

techpubsi@ appliedbiosystems.com

IMPORTANT! The e-mail address above is only for submitting comments and
suggestions relating to documentation. To order documents, download PDF files, or for
help with a technical question, go to www.appliedbiesystems.com, then click the link
for Support. (See “How to Obtain Support” below).
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How to Obtain Support

For the latest services and support information for all locations, go to
www.appliedbiosystems.com, then click the link for Support.

At the Support page, you can:

Search through frequently asked questions (FAQs)
Submit a question directly to Technical Support

Order Applied Biosystems user documents, MSDSs, certificates of analysis, and
other related documents

Download PDF documents
Obtain information about customer training
Download software updates and patches

In addition, the Support page provides access to worldwide telephone and fax numbers
to contact Applied Biosystems Technical Support and Sales facilities.
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Safety and
EMC Compliance Information

This section includes the following topics:

B Safety Conventions Used in This Document . . . ... ... . oo iiiiiiiiie. xii
B Symbols oo IStTuments. ... . . coovn vonmasimervasseansareneessssassss xiii
B Safety Labels on Instruments. .- oo inndiinde snaes dvin i sasis Xiv
B General Instrumemt Safety . . . c o c.cccviincsccotiiessiooitsonsasosissss xvi
I ChemiCAl SBFBEV . 1o oo o s s S R o TR e e s R xvil
B Chemical Waste Safety. 5 oo Co il Loy SEl bl Sy B S e e s s inm
B BlectriCal Salehy., . .o.c.conm onamarsmnn vamana s me wiis o s msisnche sssamm s XK
I Physical: Hazard Safety . s s s S e b e i S S R s
B Biological Hazard Safety ... ... ... i XXi
B Workstation Safeliy) ... ouosrs o o rtem Ronad i sikde e Rk xxi
B Safety and Electromagnetic Compatibility (EMC) Standards. .............. xxii
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Safety Convenbons Uissd in This Document

Safety Conventions Used in This Document

Safety Alert  Four safety alert words appear in Applied Biosystems user documentation at points in
Words  the document where you need to be aware of relevant hazards. Each alert
word—IMPORTANT, CAUTION, WARNING, DANGER—implies a particular level of

observation or action, as defined below:

Definitions

IMPORTANT! — Indicates information that is necessary for proper instrument operation,
accurate chemistry kit use, or safe use of a chemical.

— Indicates a potentially hazardous situation that, if not avoided, may

result in minor or moderate injury. It may also be used to alert against unsafe practices.

A WELITe] — Indicates a potentially hazardous situation that, if not avoided

could result in death or serious injury.

A PLLLeISE] - Indicates an imminently hazardous situation that, if not avoided

will result in death or serious injury. This signal word is to be limited to the most extreme
situations.

Except for IMPORTANTS, each safety alert word in an Applied Biosystems document
appears with an open triangle figure that contains a hazard symbol. These hazard
symbols are identical to the hazard icons that are affived fo Applied Biosystems
instruments (see “Safety Symbols™ on page xiii).

Examples

The following examples show the use of safety alert words:

IMPORTANT! Wear powder-free gloves when you handle the halogen lamp.

m The lamp is extremely hot. Do not touch the lamp until it has cooled to

T0OIM temperature.

CHEMICAL HAZARD. Ethanol is a flammable liquid and vapor.

Exposure causes eye, skin, and respiratory tract irntation and may cause central nervous
system depression and liver damage. Read the MSDS, and follow the handling instructions.
Wear appropriate protective eyewear, clothing, and gloves.

ELECTRICAL HAZARD. Failure to ground the instrument properly

can lead to an electrical shock. Ground the instrument according to the provided instructions.

xii Appliad Biosystems TH00/T500 Fast Real-Time PCR System Maintenanca Guide
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Symbols on Instruments

Electrical The following table describes the electrical symbols that may be displayed on
Symbols on  Applied Biosystems instruments.

Instruments
Symbol Description Symbol Description
Indicates the On position of the | Indicates a terminal that may be
main power switch. — connectad to tha signal ground
- rafarenca of another instrumeant.
This is not a protacted ground
tarminal.
Indicates the Off position of the Indicates a protective grounding
main powear switch. torminal that must ba connacted
to earth ground before any other
glecirical connections are made
to the instrument.
Indicates a standby switch by Indicates a terminal that can
I which tha instrument iz switched #=® | rocoive or supply alternating
on to the Standby condition. cument or voltage.
Hazardous voltage may be
presant if this switch is on
standby.
Indicates the On/Off position of a ames | Indicates a terminal that can
push-push main power switch. L racaive or supply alternating or

direct current or voltage.

S

Safety Symbols  The following table describes the safety symbols that may be displayed on
Applied Biosystems instruments. Each symbol may appear by itself or in combination
with text that explains the relevant hazard (see “Safety Labels on Instruments”™ on
page xiv). These safety symbols may also appear next to DANGERS, WARNINGS, and
CAUTIONS that occur in the text of this and other product-support documents.

Description

Indicates that you should consult the manual for further information and to
proceed with appropriate caution.

Indicates the presenca of an elactrical shock hazard and to procaed with
appropriate caution.

Indicates the prasenca of a hot surfaca or other high-temparature hazard and
to procead with appropriate caution.

Indicatas the prasenca of a laser inside the instrument and to procesd with
appropriate caution.

Indicatas the prasenca of moving partz and to procaad with appropriate
caution.

| B > >
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Safety Labals on Instrumants

Environmental

Instruments

The following symbaol applies to all Applied Biosystems electrical and electronic
Symbols on  products placed on the European market after August 13, 2005.

Symbol

Description

European Union customears:

Call your local Applied Biosystems Customer Sarvice office for equipment
pick-up and racycling. Sae hitpfwww.appliedbiosystems.com for a list of
customer sarvice offices in the Europaan Union.

Do not dispose of this product as unsorted municipal waste. Follow local
municipal waste ordinances for proper disposal provisions to reducs the
environmantal impact of waste alectrical and elactronic equipmeant (WEEE).

Safety Labels on Instruments

The following CAUTION, WARNING, and DANGER statements may be displayed on
Applied Biosystems instruments in combination with the safety symbols described in the

XV

preceding section.

English

Francais

CAUTION Hazardous chemicals. Read the
Material Safety Data Shaets (MSDSs) before
handling.

ATTENTION Produits chimigues dangeuraus.
Lire laz fichas technigues de =ireté de
matérials avant |la manipulation des produits.

CAUTION Hazardous waste. Refer to
MSDE{=) and local regulations for handling
and disposal.

ATTENTION Déchets dangeraw. Lire las
fichas tachniques da sdraté de matariels ot la
régulation locale associées 4 la manipulation
et I'élimination des déchats.

WARNING Hot lamp.

AVERTISSEMENT Lamps brillante.

WARNING Hot. Replace lamp with an
Appliad Biosystams lamp.

AVERTISSEMENT Composants bridants.
Remplacer la lampe par uns lampe
Applied Biosystams.

CAUTION Hot surface.

ATTENTION Surface britlante.

DANGER High voltags.

DANGER Haute tension.

WARNIMG To reducs the chance of elactrical
shiock, do not remove covars that require tool
access. No user-sarviceabls parts are inside.
Refar zarvicing to Applied Biosystems
qualified servica personnel.

AVERTISSEMENT Four aviter les risquas
d"@lactrocution, ne pas retirer les capots dont
|'ouverture nécassite |'utilisation d'outils.
Linstrumeant na contient awcuna piécea
réparabla par I'utilisatewr. Touts infervention
doit &ire effectude par le personnel da sarvice
qualifié da Applied Biosystems.

CAUTION Moving parts.

ATTENTION Parties mobiles.

WARNING This instrument is designed for
12V, 75W Halogan lamps only.

AVERTISSEMENT Cst instrument est congu
pour des lampas d'halogéne da 12V ot 75W
seulement.
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Safety Labels on instruments

Locations of The Applied Biosystems 7500/7500 Fast Real-Time PCR System contains warnings at
Warnings the locations shown below.
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Ganeral lnstrument Safafy

General Instrument Safety

Moving and
Lifting the
Instrument

Moving and
Lifting
Stand-Alone
Computers and
Monitors

Operating the
Instrument

PHYSICAL INJURY HAZARD. Use this product only as

specified in this document. Using this instrument in a manner not specified by
Applied Biosystems may result in personal imjury or damage to the instrument.

PHYSICAL INJURY HAZARD. The instrument is to be moved

and positioned only by the personnel or vendor specified in the applicable site
preparation guide. If vou decide to lift or move the instrument after it has been installed,
do not attempt to lift or move the instrument without the assistance of others, the use of
approprizte moving equipment, and proper lifting technigues. Improper lifting can cause
painful and permanent back mjury. Depending on the weight, moving or lifting an
instrument may require two o MOTE PErSOns.

A LYRTE] Do not attempt to lift or move the computer or the monitor without

the assistance of others. Depending on the weight of the computer and/or the monitor,
moving them may require two or more people.

Things to consider before lifting the computer and/or the monitor:

= Make sure that you have a secure, comfortable grip on the computer or the monitor
when lifting.

= Make sure that the path from where the object is to where it is being moved is clear
of obstructions.

* Do not lift an object and twist your torso at the same time.

* Keep your spine in a good neutral position while lifting with your legs.

* Participants should coordinate lift and move intentions with each other before
lifting and carrying.

* Instead of lifting the object from the packing box, carefully tilt the box on its side
and hold it stationary while someone slides the contents out of the box.

Ensure that anyone who operates the instrument has:
* Received instructions in both general safety practices for laboratories and specific
safety practices for the instrument.

* Read and understood all applicable Material Safety Data Sheets (MSDSs). See
“About MSDSs™ on page xvil.

PHYSICAL INJURY HAZARD. Use this instrument as specified

by Applied Biosystems. Using this instrument in 2 manner not specified by
Applied Biosystems may result in personal injury or damage to the instrument.

Cleaning or Before using a cleaning or decontamination method other than those

Decontaminating
the Instrument

recommended by the manufacturer, verify with the manufacturer that the proposed
method will not damage the equipment.

Appliad Biosystems 75007500 Fast Real Time PCR System Maintenance Guide

v

All copies of this document are uncontrolled when printed.



Procedure for Calibration and Equipment Maintenance Version 11
Forensic Biology Section Effective Date: 12/28/2015
Issued by the Forensic Biology Forensic Scientist Manager and DNA Technical Leader

Safety and EMC Compliance Information
Chemical Safsty

Chemical Safety

Chemical Hazard CHEMICAL HAZARD. Before handling any chemicals, refer to

Warning  the Material Safety Data Sheet (MSDS) provided by the manufacturer, and observe all
relevant precautions.

CHEMICAL HAZARD. All chemicals in the instrument, including

liquid in the lines, are potentially hazardous. Always determine what chemicals have
been used in the instrument before changing reagents or instrument components. Wear
appropriate eyewear, protective clothing, and gloves when working on the instrument.

CHEMICAL STORAGE HAZARD. Never collect or store waste

in a glass container because of the risk of breaking or shattering. Reagent and waste
bottles can crack and leak. Each waste bottle should be secured in a low-density
polyethylene safety container with the cover fastened and the handles locked in the
upright position. Wear appropriate eyewear, clothing, and gloves when handling reagent
and waste bottles.

About MSDSs  Chemical manufacturers supply current Material Safety Data Sheets (MSDSs) with
shipments of hazardous chemicals to new customers. They also provide MSDSs with the
first shipment of a hazardous chemical to a customer after an MSDS has been updated.
MBSDSs provide the safety information you need to store, handle, transport, and dispose
of the chemicals safely.

Each time you receive a new MSDS packaged with a hazardous chemical, be sure to
replace the appropriate MSDS in your files.

Obtaining MSDSs  The MSDS for any chemical supplied by Applied Biosystems 1s available to you free
24 hours a day. To obtain MSDSs:

l. Goto www.appliedbiosystems.com, click Support, then click MSDS Search.

2. In the Keyword Search field. enter the chemical name. product name, MSDS part
number, or other information that appears in the MSDS of interest. Select the
language of your choice, then click Search.

1. Find the document of interest, right-click the document title, then select any of the
following:
* Open - To view the document
* Print Target — To prnt the document
» Save Target As — To download a PDF version of the document to a destination
that you choose

Note: For the MSDEs of chemicals not distributed by Applied Biosystems, contact the
chemical manufacturer.
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Chemical Safaty

Chemical Safety To minimize the hazards of chemicals:

Guidelines . Read and understand the Material Safety Data Sheets (MSDSs) provided by the
chemical manufacturer before you store, handle, or work with any chemicals or
hazardous materials. (See “About MSDSs"™ on page xvii.)

* Minimize contact with chemicals. Wear appropriate personal protective equipment
when handling chemicals (for example, safety glasses, gloves, or protective
clothing). For additional safety guidelines, consult the MSDS.

* Minimize the inhalation of chemicals. Do not leave chemical containers open. Use
only with adequate ventilation (for example, fume hood). For additional safety
guidelines, consult the MSDS.

* Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the
manufacturer’s cleanup procedures as recommended on the MSDS.

* Comply with all local, state/provincial, or national laws and regulations related to
chemical storage, handling, and disposal.
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Chemical Waste Safety

Chemical Waste HAZARDOUS WASTE. Refer to Material Safety Data Sheets and
Hazard local regulations for handling and disposal.

CHEMICAL WASTE HAZARD. Wastes produced by Applied

Biosystems instruments are potentially hazardous and can cause injury, illness, or death.

CHEMICAL STORAGE HAZARD. Never collect or store waste in a

glass container because of the risk of breaking or shattering. Reagent and waste bottles can
crack and leak. Each waste bottle should be secured in a low-density polyethylene safety
container with the cover fastened and the handles locked in the upright position. Wear
appropriate eyewear, clothing, and gloves when handling reagent and waste bottles.

Chemical Waste To minimize the hazards of chemical waste:

Safety Guidelines . Read and understand the Material Safety Data Sheets (MSDSs) provided by the
manufacturers of the chemicals in the waste container before vou store, handle, or
dispose of chemical waste.

* Provide primary and secondary waste containers. (A primary waste container holds
the immediate waste. A secondary container contains spills or leaks from the
primary container. Both containers must be compatible with the waste material and
meet federal, state, and local requirements for container storage. )

* Minimize contact with chemicals. Wear appropriate personal protective equipment
when handling chemicals {for example, safety glasses, gloves, or protective
clothing). For additional safety guidelines, consult the MSDS.

* Minimize the inhalation of chemicals. Do not leave chemical containers open. Use
only with adequate ventilation (for example, fume hood). For additional safety
guidelines, consult the MSDS.

* Handle chemical wastes in a fume hood.

+ After emptying the waste container, seal it with the cap provided.

» Dispose of the contents of the waste tray and waste bottle in accordance with good
laboratory practices and local, state/provineial, or national environmental and health
regulations.

Waste Disposal If potentially hazardous waste is generated when you operate the instrument, you must:

+ Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

* Ensure the health and safety of all personnel in your laboratory.

* Ensure that the instrument waste is stored, transferred, transported. and disposed of
according to all local, state/provineial, and/or national regulations.

IMPORTANT! Radicactive or bichazardous materials may require special handling, and
disposal limitations may apply.
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Safety and EMC Compliance Information
Flectricsl Safsty

Electrical Safety

ELECTRICAL SHOCK HAZARD. Severe electrical shock can

result from operating the Applied Biosystems 7500/7500 Fast Real-Time PCR System
without its instrument panels in place. Do not remove instrument panels. High-voltage
contacts are exposed when instrument panels are removed from the instrument.

Fuses m FIRE HAZARD. Improper fuses or high-voltage supply can

damage the instrument wiring system and cause a fire. Before turning on the instrument,
verify that the fuses are properly installed and that the instrument voltage matches the

power supply in your laboratory.

m FIRE HAZARD. For continued protection against the risk of fire,

replace fuses only with fuses of the type and rating specified for the instrument.

Power A pEel9] ELECTRICAL HAZARD. Grounding circuit continuity is vital for

the safe operation of equipment. Never operate equipment with the grounding conductor
disconnected.

A LTS ELECTRICAL HAZARD. Use properly configured and approved
line cords for the voltage supply in your facility.

A PELTES] FLECTRICAL HAZARID. Plug the system into a properly
grounded receptacle with adequate current capacity.

Overvoltage The Applied Biosystems 7500/7500 Fast Real-Time PCR System has an installation
Rating (overvoltage) category of 11, and is classified as portable equipment.

Physical Hazard Safety

Moving Parts PHYSICAL INJURY HAZARD. Moving parts can crush and cut.
Keep hands clear of moving parts while operating the instrument. Disconnect power
before servicing the instrument.
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Safety and EMC Compliance Information
Binlogical Hezard Safety

Biological Hazard Safety

General m BIOHAZARD. Biological samples such as tissues, body fluids,

Biohazard infectious agents, and blood of humans and other animals have the potential to transmit
infectious diseases. Follow all applicable local, state/provincial, and/or national
regulations. Wear appropriate protective equipment, which includes but is not limited to:
protective eyewear, face shield clothing/lab coat, and gloves. All work should be
conducted in properly equipped facilities using the appropriate safety equipment (for
example, physical containment devices). Individuals should be trained according to
applicable regulatory and company/institution requirements before working with
potentially infectious materials. Read and follow the applicable guidelines and/or
regulatory requirements in the following:

» LS. Department of Health and Human Services guidelines published in Biosafety
in Microbiological and Biomedical Laboratories (stock no. 017-040-00547-4;
bmbl.od.nih.gov)

« Occupational Safety and Health Standards, Bloodbome Pathogens (29 CFR
§1910.1030; www.access.gpo.gov/ nara'cfr/waisidx_01/29cfr1910a_01.html).

* Your company s/institution’s Biosafety Program protocols for working
with/handling potentially infectious materials.

Additional information about bichazard guidelines is available at:

www.ede.gov

Workstation Safety

Correct ergonomic configuration of your workstation can reduce or prevent effects such
as fatigue, pain, and strain. Minimize or eliminate these effects by configuring your
workstation to promote neutral or relaxed working positions.

MUSCULOSKELETAL AND REPETITIVE MOTION

HAZARD. These hazards are caused by potential risk factors that include but are not
limited to repetitive motion, awkward posture, forceful exertion, holding static unhealthy
positions, contact pressure, and other workstation environmental factors.

To minimize musculoskeletal and repetitive motion risks:

* Usg equipment that comfortably supports you in neutral working positions and
allows adequate accessibility to the keyboard monitor, and mouse.

* Position the kevboard mouse, and monitor to promote relaxed body and head
postures.
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Safety and EMC Compliance Information
Safety and Electromagnetc Compatibilty (BMG) Standerds

Safety and Electromagnetic Compatibility (EMC) Standards

This section provides information on:
= LLS. and Canadian Safety Standards
* Canadian EMC Standard
* European Safety and EMC Standards
= Australian EMC Standards

U.S.and This instrument has been tested to and complies with standard UL 61010A-1, “Safety
Canadian Safety Requirements for Electrical Equipment for Laboratory Use, Part 1: General
Standards Requirements” and with standard UL 61010-2-010, *Particular Requirements for

@ Laboratory Equipment for the Heating of Matenals.”
c us

This instrument has been tested to and complies with standard CSA 1010.1, “Safety
Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use,
Part |: General Requirements.”

Canadian EMC  This instrument has been tested to and complies with ICES-001, Issue 3: Industrial,
Standard Scientific, and Medical Radio Frequency Generators.

European Safety Safety

and EMC - _ . , o
Standards This instrument meets European requirements for safety {Low Voltage Directive

2006/95/EC). This instrument has been tested to and complies with standards

c € EN 61010-1:2001, “Safety Requirements for Electrical Equipment for Measurement,
Control and Laboratory Use, Part 1: General Requirements™ and EN 61010-2-010,
“Particular Requirements for Laboratory Equipment for the Heating of Materials,” and
with standard EN 61010-2-081:2002+A1:2002 “Particular Requirements for Automatic
and Semi-Automatic Laboratory Equipment for Analysis and Other Purposes.”

EMC

This instrument meets European requirements for emission and immunity (EMC
Directive 2004/ 108/EC). This instrument has been tested to and complies with standard
EN 61326 (Group 1. Class B). “Electrical Equipment for Measurement, Control and
Laboratory Use — EMC Requirements.”

Australian EMC  This instrument has been tested to and complies with standard AS/NZS 2064, “Limits
Standards and Methods Measurement of Electromagnetic Disturbance Characteristics of Industrial,

o Scientific, and Medical (ISM) Radio-frequency Equipment.”
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Chapter 1
Overview

This chapter covers:
B About the 75007500 Fast System ... ... oo 2
B Howto Use This Guide ... ... it ia i eaeia s 4
B Recommended Maintenance Schedule. . . ... ... . ... . .. .. ... 5
B Maintain the Computer Hard Dmive(s) .. ... ... o oL &

Mote: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems 7300/7500 Fast Real-Time PCR System Software
v2.0 by pressing F1. clicking @ in the toolbar, or selecting Help ¥ 7500 Software Help.

Motes
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n Chaptar 1 Oveniow

Aboot the FSIVT500 Fast Sy=temn

About the 7500/7500 Fast System

The Applied Biosystems 7500/7500 Fast Real-Time PCR System uses
fluorescence-based polymerase chain reaction (PCR) reagents to provide:

* (Juantitative detection of target nucleic acid sequences (targets) using real-time
analysis.
= (Jualitative detection of targets using post-PCR {endpoint) analysis.

= (ualitative analysis of the PCR product {achieved by melt-curve analysis that occurs
post-PCR).

About Data The 7500/7500 Fast system collects raw fluorescence data at different points during a
Collection PCR, depending on the type of run that the instrument performs:

Run Type Data Collection Point
Real-fima Standard curve The instrumeant collacts data following each extansion
nns step of the PCR.
Ralative standard
curve
Comparative Cr
(AACT)
Post-PCR The instrument collects data:
ﬁgpmm] Ganotyping + Befors the PCR (For presence/absance experiments,
data collection befora the PCR is optional but
recommeanded.)
+ (Optional) During the PCA. The instrument can collsct
data during the run (real-time); collecting data during
Prasence/Absence the run can be helpful for troubleshocting.
« After the PCR.

Regardless of the run type, a data collection point or read on the 7500/7500 Fast

imstrument consists of three phases:

1. Excitation — The instrument illuminates all wells of the reaction plate, exciting the
flucrophores in each reaction.

2. Emission — The instrument optics collect the residual fluorescence emitted from the
wells of the reaction plate. The resulting image consists only of light that
corresponds to the range of emission wavelengths.

3. Collection — The instrument assembles a digital representation of the residual
fluorescence collected over a fixed time interval, then stores the raw fluorescence
image for analysis.

After a run, the 7500 software uses regions of interest (ROI), optical, dye, and
background calibration data to determine the location and intensity of the fluorescence
signals in each read the dye associated with each fluorescence signal, and the
significance of the signal.

MNotes
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Chaptar1 Owvarviow n
Abaut the FSOUT500 Fast Systom

The T500/7500 Fast system uses five filters to support the following system dyes:

Filter 1 Filter 2 Filter 3 Filter 4 Filter 5
* FAM™ dye + JOE™ dye + TAMRA™ dya | » ROX™ dye Cys® dya
* SYBR® * VIC®dye * NED™ dye * Tewaz Red®
Grean dye * CYa®dye dya

For More  For information on

Information

+ The 750077500 Fast system — Refer to the Applied Biosystems 7500/7500 Fast

Real-Time PCR System Software Help.

MNote: To access the Help. select Help » T300 Software Help from within the 7500
software.

Genotyping experiments — Refer to Applied Biosystems 730007500 Fast Real-Time
PCR System Getting Started Guide for Genotyping Experimenis.

Presence/absence experiments — Refer to Applied Biosysiems 7500/7300 Fast
Real-Time PCR System Getting Started Guide for Presence/dbsence Experiments.

Relative standard curve and/or comparative C, (C,) experiments — Refer to
Applied Biosystems 7300/7500 Fast Real-Time PCR System Getting Started Guide
for Relative Standard Curve and Comparative C, Experimenis.

Standard curve experiments — Refer to Applied Biosystems 7500/7 500 Fast
Real-Time PCR System Getting Started Guide for Standard Curve Experiments.
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How to Use This Guide

This guide deseribes how to maintain the Applied Biosystems T500/7500 Fast Real-Time
PCR System. Chapters 2 through 5 of this manual describe calibrations that you must

perform as regular maintenance of the 7500/ 7500 Fast system. Chapter 6 and the appendices
contain maintenance procedures that you may need to resolve infrequent problems.

C i .
Au“m'k Title Description
2 Parform tha Regions of Describas how to parform an RO calibration, which

Interast (ROI) Calibration | allows the 7500 software to map the positions of the

wells on the sample block so that it can associate the

flucrascence collected during a run with spacific
wells of the plata.
3 Parform the Background | Describas how to perform background and optical

Calibration and Optical calibrations whare tha:

Calibration s Background calibration allows tha 7500 softwarns
to ramiove the background flucrscance from
expariment data.

+ (Optical calibration compenzates for the physical
affacts of the fifth filkar prasent in 7500/7500 Fast
systems.

4 Parfarm tha Dyea Describas how to parform dye calibrations, which

Calibration allow the software to distinguish the individweal

contribution of each dye in the total fluorescance

collectad by the instrument.
5 Varify the Instrument Describas how to parform a TagMan® Rhasa P

Parformancs Instrument Verification Plate run that can be wsad to

verify the performanca of a 750007500 Fast systam.

3] Usgr—FEff-::-rrnad Describas how to:

Maintenance # Replace the user-sarviceable paris of the
75007500 Fast system.

# Rasolve infrequent problems that can oocur
during imstrumant wuse.

A Store, Move, and Install | Describes how to store, mowve, and reinstall the
the 7500/7500 Fast comiponants of the 7500/7500 Fast systam.
Systam
B Create a Custom Dye Describes how to create a dye plate that can be used

Plate to calibrate the 75007500 Fast system for a dye not

manufactured by Applied Biosystems.

c Create a Background Describas how to create a background plate in the

Plate awvent that one is unavailabla.

MNotes
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Recommended Maintenance Schedule

The following table displays the recommended maintenance schedule for the T300/7500
Fast instrument and computer. The procedures listed in the table are intended for the
user(s) of the 7500/7500 Fast system. To ensure proper operation of your instrument,
perform the regular weekly, monthly, and semiznnual maintenance indicated below.

IMPORTANT! The numbered hsts in the table below mdicate that the tasks must be
performed in sequence.

Perform...

User-Performed Maintenance Task

See Page

Weakly

Check the computer disk space. If necessary, archiva or back up
your expariment files.

Power off the computer controlling the 7500/7500 Fast
instrument, than afier 30 sac, power on the computar.

Clean the surfaca of the 7300/7500 Fast instrument with a
limt-frea cloth.

IMPORTANT! Do not usa organic solvents to clean the 750007500
Fast system.

Monthly

1.

Check the lamp status. If necassary, replace the halogan lamip.

2. Perform a background calibration. ¢

. Run disk cleanup and disk defragmentation.

o BB

Semiannually
{& Months)

. Check the lamp status. If necassary, replaca the halogan lamp.
. Perform a regions of interst (RO calibration.

Perform a background calibration.
Perform an optical calibration.
Perform a dya calibration.

. Perform an RMase P instrument verfication run.

Az needed

Decontaminate tha 7500/7500 Fast instrument.
Raplace the Halogan Lamp.

Raplace the T500/7500 Fast instrument fuses.
Updata the Windows operating system.
Updats the 7500 softwars.

gRB|HdeRE g

&7
2]

1 You can perform a background calibration to check for contamination. If any parts of the oplics are
replaced or moved, you must rum an ROH calibration, a background calibration, an optical calibration,
a dya calibration, and an RNase P instrument verification run.

Motes
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“ Chaptar 1 Oveniow

Maintain the Computer Hard Drivefs)

Maintain the Computer Hard Drive(s)

When to = At least once every month
Defragment and = When a message is displayed by the Windows operating system instructing vou to
Clean Up the defragment
Hard Drive
For More  In the desktop, select Start » Help and Support to access the Help for the Windows
Information operating system. Use the search function of the Help to find information on the

“Disk Cleanup™ and “Disk Defragment”™ utilities.

IMPORTANT! Do not run the disk management utilities and 7500 software at the same

fime.

Archive and Back Up EDS Files

Archive EDS Files
Regularly

To conserve space on the computer hard drive, older EDS files can be archived using a
data compression utility. Several commercially available compression utilities are
available. PKZIP and *.arc are archive formats common to the Microsoft® Windows®
operating system.

Back Up EDS  Applied Biosystems strongly recommends that yvou back up your experiments.
Files Backing up data:
* Protects against potential loss of data caused by an unforeseen failure of the
computer or its hard drive(s).
= Conserves space on the hard drive and optimizes performance, if you remove old
data after backing up.
Develop a Data  Applied Biosystems recommends developing a strategy for managing the files produced
Management by the 7500 software.
Strategy
Note: Real-time runs generate significantly more data than genotyping or
presence/sbsence experiments. During one day of real-time operation, the 7500/7500
Fast system can generate more than 10 MB of data.
Check Disk  If you perform real-time experiments on your 7300/7500 Fast system, check the amount
Space of available space on your hard drive weekly. When the hard drive is within 20% of
maximum capacity, transfer the older data to a backup storage device.
Notes
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Chapter 2

Perform the Regions of Interest (ROI)
Calibration

This chapter covers:
LS T 8
B Prepare the ROI Calibration Plate. ... ... .o i 9
B Perform the Calibration . ... ... ... ... i 12
B Perform an Automated ROI Calibration. ... ... ... ... ... ... ... 12
B Perform a Manual ROl Calibration .. .. ... .. . i 13
B Troubleshoot the ROI Calibration. .. ... ... .. ... ... .. 17

Mote: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems 7500/7500 Fast Real-Time PCR System Software
v2.0 by pressing F1. clicking @ in the toolbar, or selecting Help ¥ 7500 Software Help.

Motes
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n Chaptar 2 Perform the Regions of Interest (RO Calibration
Cwanaow

Overview

A regions of interest (ROI) calibration maps the positions of the wells on the sample
block of the Applied Biosystems 7500/7500 Fast Real-Time PCR System. The 7500
software uses the ROI calibration data to associate increases in fluorescence during a run
with specific wells of the plate. The instrument uses a set of optic filters to distinguish
the fluorescence emissions gathered during runs. You must generate a calibration image
for each individual filter to account for minor differences in the optical path.

Mote: The ROI calibration is a user-performed maintenance procedure.

Time Required 30 min

Materials
Required
[ P
:.Zf |
' —,
ROl Calibration
Applied Biosystems Flate plats adapter
Feal-Time PCH
Systam Spectral
Calibraticn Kit

When to Performm  Perform an ROI calibration:

the Calibration = When installing the T500/7500 Fast system. You must perform in sequence the ROL,
background, optical, and dye calibrations and the instrument verification run.

= Ewvery 6 months, or as often as necessary, depending on instrument use.
= After replacing the lamp.

IMPORTANT! After every ROI calibration, you must perform a background calibration,
optical calibration, dye calibration, and instrument verification.

MNotes
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Chapter 2 Parform the Regions of Interest (ROI) Calibration n

Prepare the ROI Calibration Plate

Frapare the ROY Calibration Plafe

Standard Plates Use the plate appropriate for your 7500/7500 Fast system.

Versus Fast
Plates

Prepare the Plate

Motes

Standard Plates - T500 Systems

Fast Plates - 7500 Fast Systems

Motched cornar at top right

top-night

100-pL [ |
maxdmum  °

. WAVAVAYAVAYAN AN
e VVAVAVATAVATAY

Vortex standard plates to ensure complate
mixing, then centrifuge to ensura that all
reagents are contained in the bottom of the
well.

Optical 96-Well Fast

Plates do not fit comectly into the standard
block.

Motched cormer at top left

Alat
notchad
top-left
cornar

MaKimum =
reaction T

volume — I'...'I IIIJ' I'u'l U I'...'I 'I..lr 1'...

Centrifuge Fast plates to ensure that all
raagents ara in the bottom of the well.

Do not vortex Fast plates. Vortexing can
causs loss of smaller reaction volumeas.

A (oM glelf) Standard plates are not

compatibla with the 7500 Fast system and
may be crushed by the 96-Well Fast Block.

IMPORTANT! Wear powder-free gloves when you handle the ROl calibration plate.

1. Obtain the ROl calibration plate from the spectral calibration kit in the freezer.

2. Allow the RO calibration plate to warm to room temperature (approximately 5 min).

IMPORTANT! D}o not remove an ROI calibration plate from its packaging until you
are ready to run it. The fluorescent dye in the wells of the plate is photosensitive.
Prolonged exposure to light can diminish the flucrescence from the plate.
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n Chapter 2 Perform the Regions of Interest (ROf) Calibration
‘ Prapare the ROY Calbration Plate

3. Remove the ROI calibration plate from its packaging. Leave the optical film on the
plate.

IMPORTANT! Do not discard the packaging for the ROI calibration plate. The plate
can be used up to three times if it is stored in its original packaging sleeve.

4. (Standard plates only) Vortex the ROI calibration plate for 5 sec.

IMPORTANT! Do not vortex Fast plates.

(The remaining steps apply to both standard and Fast plates.)
5. Centrifuge the plate for 2 min at less than 1500 rpm.

IMPORTANT! The ROI calibration plate must be well mixed and centrifuged.

6. Verify that the liquid in each well of the ROI calibration plate is at the bottom of the
well. If not, centrifuge the plate again at a higher rpm and for a longer period of time.

R Y V ®®

Liquid is at * Not cantrifuged with enough force,
. bottom of well. or

2

* Not cantrifuged for enough time

Notes
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Chapter 2 Parform the Regions of Interest (ROI) Calibration m
Frapare the ROY Calibration Plafe

Load the Plate M PHYSICAL INJURY HAZARD. During instrument operation, the

sample block can be heated to 100 °C. Before performing the following procedure, be
sure to wait until the sample block reaches room temperature.

1. Push the tray door to open it.

2. Load the plate into the plate holder in the instrument. Ensure that the plate is
properly aligned in the holder.

Load standard plates Load Fast plates (7500
(7500 system) with the Fast systam) with tha

notched A12 position at notched Al position at
the top-right of the tray. the top-left of the tray.

Motes
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n Chaptar 2 Perform the Regions of Interest (RO Calibration

Perform the Calibration

Automated
Versus Manual
Calibrations

The 7500 software allows you to perform the RO calibration automatically or manually.

o ailt:l:rc:tim Description Use for... See Page
Automatic (Movice users) Awizard intarface | Fegular calibrations 12
guidas you through the
calibration.
Manual {Advancad users) An interface + Hagular calibrations 13
similar to previous vwarsions of « Custom calibration
the software that allows you to e mgg"'?ﬂ
parform the calibration manualty.

Perform an Automated ROI Calibration

Start the
Calibration

MNotes

1. In the 7500 software, select Instrument » Instrument Maintenance Manager.
2. In the ROI screen of the Instrument Maintenance Manager, click Start Calibration.

3. Complete the calibration as instructed by the wizard.

The ROI Calibration dialog box displays three tabs:
* Setup — Displays instructions for setting up the ROI calibration. Clicking MNext
prompts opens the Run tab.
* Run - Clicking START RUN starts the calibration process and displays the
processing messages. Clicking Next opens the Analysis tab.
* Analysis — Indicates the calibration status (Passed/Failed).

If you cannot obtain a passing calibration, see “Troubleshoot the ROI Calibration”™
on page 17.

12

Appliad Biosystems 75007500 Fast Real Time PCR System Maintenance Guide

v

All copies of this document are uncontrolled when printed.



Procedure for Calibration and Equipment Maintenance

Forensic Biology Section

Issued by the Forensic Biology Forensic Scientist Manager and DNA Technical Leader

Chapter 2 Parform the Regions of Interest (ROI) Calibration n
Perform the Calibration

Perform a Manual ROl Calibration

Startthe 1.

Calibration

In the 7500 software, select Instrument » Instrument Maintenance Manager.

2. In the ROI tab of the Instrument Maintenance Manager, click Start Manual

Motes

Calibration.

In the ROI Inspector dialog box:
a. In the Exposure Time field, enter 2048.
b. Select Filter A (Filter 1).

I |
DT Condpd St ings
Erxparisa T jrz) |Il-li T S— 3:[
L Conderd
[ 2]  Momlade |

ke s Frov
Fie & 41— 3b

)

moaon

Click Snapshot to generate an ROI image.

Determine if your ROl image is acceptable (the figures below show unsaturated and
oversaturated images). Wells in an acceptable image:

* Must be as bright as possible without oversaturating. { When you generate the
RO calibration, a warning is displayed if wells are oversaturated.)

* Can contain some, but do not have to contain any, red pixels, which represent

saturabion.
Mormal Over
Unsaturated | g 4 ration Saturated
Good Accaptable | Mot Acceptable

If your ROl image is acceptable, go to step 7.

If your ROl image is oversaturated. decrease the Exposure Time by half, then
click Snapshot. Repeat until you obtain an acceptable ROI image.

If you cannot obtain an acceptable image, see “Troubleshoot the ROI Calibration™
on page 17.
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Chapter 2 Perform the Regions of interest (ROf) Calibration

Perform the Calibration

7. Click Generate Calibration.

The 7500 software takes a snapshot, then displays a message box or an ROl image:

If the software displays:

Do the following:

t Thamaga iz v axpazadard carnot be used to calbrate tha ndr unart,

b4 Plassereduce thassposre tine and by 350
or
7500 v2.0 3]
[rapn evpozurs k600 low For vald colbeabon, poss ble causes

Q

(1) Lom eponss

[2) Nissing cltaation phys

(3) Laepis off o bumsd ok

[4) Sradtas s chsed

The ce beabion process wall ek cont rue vith the cument mage

Flamuircreams the sopowre tre andiry sgen

a. Click OK.

b. Decraase the Exposure Time by
half (sese step 3a on page 13).

c. Repeat steps 2 and 5.

A very faint ROl image, or you cannot generate a
successful calibration.

See "Troubleshoot the ROI Calibration™

on page 17.

An accaptable Calibration Image

Note: Green circles appear around all walls
indicating that the welis calibrated successfully.

Note: A green circle indicates that the region of
interest for the well position is bright enough.

Verify that the:

e Wells Found value is 96.

g b
e

| Succassful
calibration -
Wells Found

must be 98

* ROl Image displays a green circle
around each well area.

8. Click Save Calibration.

The software saves the newly generated ROI calibration for Filter 1. “OK™ appears
next to Filter 1 in the Filter Masks Loaded section of the ROI Inspector.
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Chapter 2 Parform the Regions of Interest (ROI) Calibration n
Perform the Calibration

9. Repeat steps 3 through 8 for the remaining filters, resetting the Exposure Time to
2048 before performing the calibration for each filter. The ROI calibration is
complete when Filter Masks Loaded for all the filters displays OK.

LD Conbal # sing:
Esponme Tive jre] |25 =
L= Cionbcd

1de v Mokl
Capbaum krags From

Flar 7 &
-
-

monm

Faallntendy 1H
Wl Fourd 56

Srapshat

S [ aibwatan

Fllar Mazks Leadad
£ K

BO¥ e
o ——————1— Calibration i complets when Filter

o Masks Loaded is OK for all Filters

E: DK

Oone

10. Chick Done.

Motes
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Periomm the Calibration

Unload the Plate mm PHYSICAL INJURY HAZARD. During instrument operation, the

sample block can be heated to 100 °C. Before performing the following procedure, be
sure to wait until the sample block reaches room temperature.

1. Remove the calibration plate:
a. Push the tray door to open it.
b. Remove the calibration plate.

c. Push the tray door to close it.

2. Place the calibration plate inside its packaging sleeve. [f you plan to perform
background and optical calibrations:

*  Within the next ¥ hr, keep the ROl calibration plate at room temperature. The
optical calibration uses the ROI calibration plate.

* On another day, return the packaged plate to the spectral calibration kit in the
freezer.

IMPORTANT! Do not discard the calibration plate. If the plate is stored in its
original packaging sleeve, you can use it up to three times after you open it.

Continue with *““Perform the Background Calibration and Optical Calibration™ on
page 19.

IMPORTANT! After you perform an ROl calibration, you must also perform a
background calibration (see page 20). an optical calibration (see page 25), dye
calibrations (see page 32), and instrument verification (see page 46).

MNotes
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Troubleshoot the ROI Calibration

Problem/Symptom Possible Cause Action

ROl Calibration The samiple block may be | 1. I the CCD Control Sattings in the ROl Inspector displays
Failed in its loweared position. “Block Up," click Block Up, to raisa the block.

LD Conbol 5 sings
Ewporums Tira frs] 104 —
Laing Conbicl

Ide - Bieklp ] Click

Ciaphurm g From
Filar & &

2. Check that the heated cover assamibly is pulled all the way forward

to ensure that the tray can be pushed in property. If the 750007500
ROl Image is Faint Fast system has a heated cover latch installed, chack that the latch
i5 in a locked positicn.

3. If the RO calibration continues to fail, check the status of the
halegen lamp within the 7500/7500 Fast instrumeant (sae “Monitor
the Lamp Status™ on page 58), then raplace the lamp if necessary
{sea "Raplace the Halogen Lamp™ on page 63).

Motes
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Perform the Background Calibration
and Optical Calibration

This chapter covers:
B Perform the Background Calibration . . ... ... ... . o oL 20
B Prepare the Background Calibration Plate. .. ... ... ... o oot 21
B Perform the Background Calibration. . ... ... oo i 23
B Perform the Optical Calibration .. ... ... oo i 25
B Prepare the Calibration Plate . ... ... ..o o oo 25
B Perform the Optical Calibration. . ... ... e 28
B Troubleshoot the Background Calibration . ... ... oo oo oL an

Mote: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems 7500/7500 Fast Real-Time PCR System Software
v2.0 by pressing F1. clicking @ in the toolbar, or selecting Help » 7500 Software Help.

Motes
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Perform the Background Calibration

During a background calibration, the T500/7500 Fast system:

* Performs reads of a background plate containing PCR. buffer for 10 min at 60 =C.

*  Averages the spectra recorded during the nn and extracts the resulting spectral

component to a calibration file.

The 7500 software then uses the calibration file during subsequent runs to remove the

background flucrescence from the run data.

Mote: The background calibration is a user-performed maintenance procedure.

Time Required 30 min

Materials Back d

Required Pgrtoaun
J
|

Applied Biosystems 7500/7500
Fast Real-Time PCR Systam
Spectral Calibration Kit

When to Perform  Perform a background calibration:

adapter

the Calibration » When installing the 7500/7500 Fast system. You must perform in sequence the ROI,
background, optical, and dye calibrations and the instrument verification run.

* Monthly, or as often as necessary, depending on instrument use.

= After replacing the lamp.

Background Fluorescence data collected by the 7500/7500 Fast system includes a fluorescence signal
Fluorescence inherent to the system, referred to as background fluorescence. Background fluorescence
is a composite signal found in all spectral data. This signal consists of fluorescence from

several sources, including:
* Background electronic signal
* Contaminants in the sample block
* The plastic consumable (plates and caps)

Guidelines for = Make sure the centrifuge you use is clean. Before centrifuging, wipe down the

Calibration bucket using a tissue.

* Handle the calibration plates with care to prevent contamination. Do not place plates
on a lab bench, which may contaminate the plate. Always put calibration plates back

into their original bags.

MNotes
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Prepare the Background Calibration Plate

Prepare the Plate IMPORTANT! Wear powder-free gloves when you handle the plate.

1. Obtain the prepared background plate from the spectral calibration kit in the freezer.
2. Allow the background plate to warm to room temperature {at least 5 min).

3. Remove the background plate from its packaging.

IMPORTANT! Do not discard the packaging for the plate. The background plate can
be used up to three times if it is stored in its original packaging sleeve.

T I-"\ .II I.

4. (Standard plates only) Vortex the plate for 5 sec.

IMPORTANT! Do not vortex Fast plates.

{The remaining steps apply to both standard and Fast plates.)}

5. Centrifuge the plate for 2 min at less than 1500 rpm.

IMPORTANT! The plate must be well mixed and centrifuged.

6. Verify that the liquid in each well of the background plate is at the bottom of the well.
If not, centrifuge the plate again at a higher rpm and for a longer period of time.

IMPORTANT! Do not allow the bottom of the background plate to become dirty.
Fluids and other contaminants that adhere to the bottom of the plate can contaminate
the sample block and cause an abnormally high background signal.

Comect Incomect
-~ -
"\. U
ya ' ! ' Liquid iz at *  Not centrifuged with anough force, or
! ) bottom of well. = Mot centrifuged fior encugh time
Motes
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Load the Plate mm PHYSICAL INJURY HAZARD. During instrument operation, the
sample block can be heated to 100 °C. Before performing the following procedure, be

sure to wait until the sample block reaches room temperature.

1. Push the tray door to open it.

2. Load the plate into the plate holder in the instrument. Ensure that the plate is
properly aligned in the holder.

Load standard plates Load Fast plates (7500
{7500 system) with tha Fast systam] with the
notched A12 position at notched A1 position at the
the top-right of the fray. top-left of the tray.

4P Push

Mote: If you cannot open the tray, the sample block may be in its raised position, locking the
tray door position. To lower the block, select Instrument » Calibrate, then exit the ROI
Inspector.

MNotes
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Perform the Background Calibration

Perform the 1. Inthe 7500 software, select Instrument » Instrument Maintenance Manager.

Calibration ]
2. In the Instrument Maintenance Manager, select the Background tab.
3. Inthe Background tab, click Start Calibration.

4. Complete the calibration as instructed by the wizard.

The Background Calibration dialog box displays four tabs:
« Overview — Displays information describing the calibration.
+ Setup — Displays instructions for setting up the background calibration.
Clicking Mext prompts opens the Run tab.

* Run - Clicking START RUN starts the calibration process and displays the
processing messages. Clicking Next opens the Analysis tab.

*  Amnalysis — Indicates the calibration status (Passed/Failed).

If you cannot obtain a passing calibration, see “Troubleshoot the Background
Calibration™ on page 30.

Mote: Before starting the calibration, the instrument may pause (up to 10 min) to allow
the heated cover to reach temperature.

Motes

Applied Biosystems 75007500 Fast Real-Time PCR System Maintenance Guide 23

v

All copies of this document are uncontrolled when printed.



Procedure for Calibration and Equipment Maintenance Version 11
Forensic Biology Section Effective Date: 12/28/2015

Issued by the Forensic Biology Forensic Scientist Manager and DNA Technical Leader

m Chaptar 3 Perform the Background Calibration and Optical Calibration
Perfonm the Badkground Calbration

Unload the Plate mm PHYSICAL INJURY HAZARD. During instrument operation, the
sample block can be heated to 100 °C. Before performing the following procedure, be

sure to wait until the sample block reaches room temperature.

1. Remove the calibration plate:
a. Push the tray door to open it.
b. Remove the calibration plate.

¢. Push the tray door to move it into the instrument.

2. Place the calibration plate inside its packaging sleeve, then return the packaged plate
to the spectral calibration kit in the freezer.

IMPORTANT! Do not discard the calibration plate. If the plate is stored in its
original packaging sleeve, you can use the plate up to three times after you open it.

If necessary, continue with *Perform the Optical Calibration” on page 25.

You must perform an optical calibration (see page 25), dye calibrations (see page 12),
and instrument verification (see page 46) if you are performing the background
calibration:

= Aspart of your semiannual maintenance
= After replacing or moving any parts of the optics

For more information, see “Recommended Maintenance Schedule™ on page 5.

MNotes
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Perform the Optical Calibration

Time Required

Materials
Required

When to perform
the Calibration

The optical calibration generates data that allows the 7500 software to compensate for the
physical effects of the fifth filter in the T500/7500 Fast system.

Mote: The optical calibration is a user-performed maintenance procedure.

10 i

RO calibration plate

Perform an optical calibration:

* When installing the 7500/7500 Fast system. You must perform in sequence the ROI,
background, optical, and dve calibrations and the instrument verification run.

* Ewvery 6 months, or as often as necessary, depending on instrument use.

Prepare the Calibration Plate

Prepare the Plate

Motes

If you kept your ROI calibration plate at room temperature after performing an ROI
calibration (see Chapter 2), skip to step 5 on page 26 to spin down any condensation that may
have formed when the plate was at room temperature. If the ROI calibration plate is in the
freezer, go to step 1.

IMPORTANT! Wear powder-free gloves when you handle the plate.

1. Obtain the ROI calibration plate from the spectral calibration kit in the freezer.
2. Allow the ROI calibration plate to warm to room temperature (at least 5 min).

3. Remove the ROI calibration plate from its packaging.

IMPORTANT! Do not discard the packaging for the plate. The RO calibration plate
can be used up to three times if it is stored in its original packaging sleeve.
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4. (Standard plates only) Vortex the plate for 5 sec.

IMPORTANT! Do not vortex Fast plates.

i The remaining steps apply to both standard and Fast plates.)
5. Centrifuge the plate for 2 min at less than 1500 rpm.

IMPORTANT! The ROI calibration plate must be well mixed and centrifuged.

6. Venfy that the liguid in each well of the ROI calibration plate is at the bottom of the
well. If not, centrifuge the plate again at a higher rpm and for a longer period of time.

Correct Incomrect
|J-.'I|IJIC| is at + Mot centrifuged with encugh force,
bottom of wall. or

+ Mot centrifuged for enouwgh tima

MNotes
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Load the Plate M PHYSICAL INJURY HAZARD. During instrument operation, the

sample block can be heated to 100 °C. Before performing the following procedure, be
sure to wait until the sample block reaches room temperature.

1. Push the tray door to open it.

2. Load the plate into the plate holder in the instrument. Ensure that the plate is
properly aligned in the holder.

Load standard plates Load Fast plates (7500
(7500 system) with the Fast system) with the

notched A12 position at notched Al position at
thie top-right of the tray. the top-left of the tray.

Motes
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Perform the Optical Calibration

Perform the 1. In the 7500 software, select Instrument » Instrument Maintenance Manager.

Calibration )
In the Instrument Maintenance Manager. select the Optical tab.

In the Optical screen, click Start Calibration.

AR p

Complete the calibration as instructed by the wizard.
The Optical Calibration dialog box displays four tabs:
* Owerview — Displays information describing the calibration.
+ Setup — Displays instructions for setting up the optical calibration. Clicking
Next prompts opens the Run tab.
* Run - Clicking START RUN starts the calibration process and displays the
processing messages. Clicking Next opens the Analysis tab.
*  Amnalysis — Indicates the calibration status (Passed/Failed).

If you cannot obtain a passing calibration, see “Troubleshoot the Background
Calibration™ on page 30.

Mote: Before starting the calibration, the instrument may pause (up to 10 min) to allow
the heated cover to reach temperature.

Unload the Plate m PHYSICAL INJURY HAZARD. During instrument operation, the
sample block can be heated to 100 °C. Before performing the following procedure, be

sure to wait until the sample block reaches room temperature.

1. Remove the calibration plate:
a. Push the tray door to open it.
b. Remove the calibration plate.

c. Push the tray door to move it into the instrument.

MNotes
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2. Place the calibration plate inside its packaging sleeve. Return the packaged plate to
the spectral calibration kit in the freczer.

IMPORTANT! Do not discard the calibration plate. If the plate is stored in its
original packaging sleeve, you can use it up to three times after you open it.

Continue with “Perform the Dye Calibration” on page 31.

Motes
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Troubleshoot the Background Calibration

Problem/Symptom Possible Causa Action
Background One or more walls of the 1. Repeaat the calibration using the sama background plata.
Calibration Failed ﬁ;ﬂﬂﬁ;} plate produced 2. If the calibration fails again, repeat the calibration using a
missirnum limit for the different background plate.
instrument. 3. If the calibration fails again, determine the source of the

contamination, as explained in “How to [daentify
Contamination” babow.

How to Identify  Signals that exceed the limit of normal background fluorescence may indicate

Contamination fluorescent contaminants on the calibration plate or the sample block. Common
contaminants include ink residue from permanent pens, powder from disposable gloves,
and dust.

To determine the source and location of the contamination:

1. While viewing the raw spectra, locate the contaminated well position(s) by selecting
successively smaller regions of the plate layout.

2. Rotate the background plate 1807, then perform the background calibration again.

3. Repeat step | to locate the contamination. If the well position(s) of the
contamination in steps | and 3 are:

* ldentical — The sample block is contaminated. Decontaminate the sample
block as explained in “Decontaminate the Sample Block™ on page 59.

* Reversed — The background plate is contaminated. Discard the background
plate and perform the background run using a new background plate.

If the calibration fails after you replace the background plate and decontaminate the
sample block:

1. Load a plate covered by a piece of black paper into the 7500/7500 Fast instrument.
2. Perform the background run as explained in this chapter.
3. After the run is complete, select all wells of the plate layout.

4. View the Spectral plot for the peaki(s). If a peak is:
* Visible — The optics of your 7500/7500 Fast instrument may be contaminated.
Contact Applied Biosystems as explained in “How to Obtain Support™ on
page x.

* Absent — The sample block is contaminated. Decontaminate the sample block
as explained in “Decontaminate the Sample Block™ on page 59.

MNotes
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m Perform the Dye Calibration

This chapter covers:

L T A 32
B Prepare the Dye Calibration Plates. .. ... ..o oo i5
B Perform the Dye Calibration. . ... ... .. i i 16
B Troubleshoot the Dye Calibration. .. .. ... ... o i 41

Mote: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems 7500/7500 Fast Real-Time PCR System Software
v2.0 by pressing F1. clicking @ in the toolbar, or selecting Help ¥ 7500 Software Help.

Motes
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Overview

Time Required

Materials
Required

When to Perform
Dye Calibration

MNotes

During a dye calibration, the Applied Biosystems T500/7500 Fast Real-Time PCR System:
= Collects spectral data from a series of dye standards.
* Stores the spectral information for the dye standards in a pure spectra calibration file.

The software uses the pure spectra data during experiment runs to characterize and
distinguish the individual contribution of each dye in the total fluorescence collected by
the instrument. After each run, the 7300 software receives data in the form of a raw
spectra signal for each reading. It determines the contribution of each fluorescent dye
used in the sample by comparing the raw spectra to the pure spectra calibration data.
When you save an expeniment after analysis, the software stores the pure spectra with the
collected fluorescence data for that experiment.

MNote: The dye calibration is a user-performed maintenance procedure.

| hr

Applied Biosystems 7500/ 7500
Fast Roal-Time PCRH System
Spectral Ga]ibratbn Kit

e
|

__l' ; I. _'_L

.lll

T T

1
1 ’ &l_
Dg,rg F‘Iaies
{CYa®, CY5®, FAM™, JOE™, NED™, ROX™, SYBR®
Green, TAMBA™, TEXAS RED®, and VIC® dyes)

Powdar-frea C@ntnfuga with
glovas plate adapter

Mote: If vou store Applied Biosystems T500/7500 Fast Real-Time PCR System dye
plates in their original packaging in the freezer, you can use them to calibrate a
T500vT500 Fast instrument up to 3 times for & months after opening them.

Perform a dye calibration:

= When installing the T500/7500 Fast system. You must perform in sequence the ROI,
background, optical. and dye calibrations and the instrument venfication run.

= Ewvery 6 months, or as often as necessary, depending on instrument use.

IMPORTANT! You must perform a background run before every series of dye
calibrations. Because the age and use of instrument components can affect pure spectra

readings, Applied Biosystems recommends performing a dye calibration at least every
& months.

a2
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Dye Sets The Applied Biosystems T300/7500 Fast Real-Time PCE. Systems use the following dye
sets for calibration: CY3* dye, CY5® dye, FAM™ dye, JOE™ dye, NED™ dye, ROX™ dye,
SYBR® Green dye, TAMRA™ dye, TEXAS RED* dye, and VIC*® dye. The following
figure shows the emission spectrum for each dye. and the filters and wavelengths at
which each dye is read.

Filters
Spectrum

(nmy}

Emission

Spectra

) (e

Pure Dyes -~520 nm ~5680 nm  ~580 nm ~610 nm ~650 nm
* FAM + JOE + TAMBA + ROX CYE
* SYBR Green + VIC = NED « TEXAS RED
+«CY3

Custom Dye  The 7500/7500 Fast system can be used to run assays designed with custom dyes (dyes
not supplied by Applied Biosystems). However, before using custom dyes with the
T500/7500 Fast instrument, you must create and run a custom calibration plate. The 7500
software uses the custom calibration plate to create a spectral standard to distinguish the
custom dye in the fluorescence data collected during the run. See Appendix B for
information on custom dye calibrations.

IMPORTANT! To use a custom dye on your 7500/7500 Fast system, it must fluoresce
within the 520 to 650 nm spectral range measured by the 7500/7500 Fast instrument.

Motes
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MNotes

About the
Analysis

The product of a dye calibration is a collection of spectral profiles that represent the
fluorescence signature of each dye standard. Each profile consists of a set of spectra that
correspond to the fluorescence collected from the wells of the spectral calibration plate.
The 7500 software plots the resulting data for each spectral profile in a graph of
fluorescence versus filter.

When the 7500 software extracts the calibration data from a dye run, it evaluates the
fluorescence signal generated by each well in terms of the collective spectra for the entire
calibration plate. Dye spectra are generally acceptable if they peak within the same filter
as their group but diverge slightly at other wavelengths (see below).

The 7300 software can compensate for some differences in a spectral profile by replacing
{auto-repairing) the spectra of unacceptable wells with the spectra of other wells on the
reaction plate. However, the software allows only a few replacements and may reject the
calibration if the spectra between neighboring wells vary significanthy.

Mote: Because the wells in a calibration plate contain dyes at identical concentrations,
the resulting signals for the wells containing each dye should be similar. Among wells
containing the same dye, variations in spectral position and peak position are caused by
minor differences in the optical properties and excitation energy between the individual
wells.

Acceptable Spectra
o Spectra peak at the same wavalangth and
do not diverge significantly

Horsnalorad Flser meomson
5 =

Unacceptable Spectra
O Spactra poak at the differant wavelangths

Hermnalesd Flesr spcmcn
u
e
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Prepare the Dye Calibration Plates

IMPORTANT! Before performing a dye calibration, you must perform an RO calibration
(see page 8), a background calibration (see page 20), and an optical calibration (see page 25).

Prepare the IMPORTANT! Wear powder-free gloves when you handle the plate.
Plates

1. Obtain the spectral calibration kit from the freezer, then remove all of the dve plates.
2. Return the spectral calibration kit to the freezer.

3. Allow the dye plates to warm to room temperature {approximately 5 min).

IMPORTANT! Do not remove a dye plate from its packaging until you are ready to run it.
The fluorescent dye in the wells of each dye plate is photosensitive. Prolonged exposure
to light can diminish the fluorescence signal strength of the plate.

MNote: If you store Applied Biosystems 7500/7500 Fast Real-Time PCR System dye
Plates in their original packaging in the freezer, you can use them to calibrate a
T500/7500 Fast instrument up to 3 times for & months after opening them.

Continue with “Perform the Dye Calibration” on page 36.

Motes
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Perform the Dye Calibration

Perform the 1. Inthe 7500 software, select Instrument ¥ Instrument Maintenance Manager.
Calibration

In the Instrument Maintenance Manager. select the Dye tab.

In the Diye screen, select System Dwe Calibration.

Click Start Calibration.

L N

Complete the calibration for each plate as instructed by the wizard.

IMPORTANT! The wizard guides you through the calibration of each dye separately.
You must set up, run, and analyze each dye plate independently.

The Dye Calibration dialog box displays four tabs:
*  Overview — Displays information describing the calibration.
When the software prompts you to obtain the required materials, select the dyes
that you want to calibrate.
* Setup — Displays instructions for setting up the dye calibration. Clicking Next
prompts opens the Run tab.
When the software prompts you to load each dye plate, prepare and load the
plates as described in “Load a Dye Plate™ on page 37.
* Run — Clicking START RUN starts the calibration process and displays the
processing messages. Clicking Next opens the Analysis tab.
*  Analysis — Indicates the calibration status (Passed/Failed).
When the software prompts you to analyze the spectra collected from each dye plate,
verify the status of the calibration:
* [Passed — The 7500/7500 Fast instrument passed the calibration. Go to
“Amnalyze the Calibration Data” on page 39.

» Failed — The 7500/7500 Fast instrument failed the calibration. Troubleshoot
the error as described in “Troubleshoot the Dye Calibration™ on page 43.

Mote: Before starting the calibration, the instrument may pause (up to 10 min) to
allow the heated cover to reach temperature.

MNotes
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Load a Dye Plate MNote: Because the wizard guides you through the calibration of each dye separately,
perform the following procedure for each dye that you calibrate.

1. Remove the dye plate that is specified by the software from its packaging.

IMPORTANT! Do not discard the packaging for the plate. The plate can be used up
to three times if it is stored in its original packaging sleeve.

2. (Standard plates only) Vortex the plate for 5 sec.

IMPORTANT! Do not vortex Fast plates.

{The remaining steps apply to both standard and Fast plates.)

3. Cenirifuge the plate for 2 min at less than 1500 rpm.

IMPORTANT! The plate must be well mixed and centrifuged.

4. Verify that the liquid in each well of the plate is at the bottom of the well. If not,
centrifuge the plate again at a higher rpm and for a longer period of time.

» /| @9

Liquid is at = Mot centrifuged with enough forca,
bottom of well. o

= Mot centrifuged for enough time

5. Verify that the dye plate that you are about to load matches the dye selected in the
T500 software.

Dye label

6. Push the tray door to open it.

Motes
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7. Load the plate into the plate holder in the instrument. Ensure that the plate is
properly aligned in the holder.

Load standard plates Load Fast plates (7500
(7500 systam) with the Fast system) with tha

notched A12 position at notched A1 position at
the top-right of the fray. the top-laft of the tray.

8. Close the tray door. Apply pressure to the right side of the tray door at an angle.

Note: If you cannot open the tray, the sample block may be in its raised position, locking the
tray position. To lower the block, select Instrument ¥ Calibrate, then exit the RO Inspector.

MNotes
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Analyze the Note: Because the wizard guides you through the calibration of each dye separately.
Calibration Data perform the following procedure for each dye that you calibrate.

1. Verify the status of the calibration:
+ Passed — The 7500/7500 Fast instrument passed the calibration. Go to step 2.
* Failed — The 7500/7500 Fast instrument failed the calibration. Troubleshoot

the error as described in “Troubleshoot the Dye Calibration™ on page 43.
2. Venfy the grouping of the dye spectra:
a. In the plate layout. select the wells of the plate.
b. Inspect the raw data. For each spectrum, verify that the peak is:
» Within the detectable range for the 7500/7500 Fast instrument.
* Free of irregular spectral peaks.
* Present in the correct channel for the dye (see Table | on page 41).

If a spectrum does not match the criteria above, troubleshoot the problem as
described in “Troubleshoot the Dye Calibration™ on page 43.

Note: Among wells containing the same dye. variations in spectral position and
peak position are caused by minor differences in the optical properties and
excitation energy between the individual wells.

3. If all spectra are acceptable. then click Next.
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4. Remove the calibration plate:

@mnm PHYSICAL INJURY HAZARD. During instrument

operation, the sample block can be heated to 100 °C. Before performing the
following procedure, be sure to wait until the sample block reaches room
temperature.

a. Push the tray door to open it.
b. Remove the calibration plate.

c. Push the tray door to close it.

d. Place the calibration plate inside its packaging sleeve. Return the packaged
plate to the spectral calibration kit in the freezer.

Note: If you store Applied Biosystems 7500/7500 Fast Real-Time PCR System
dye plates in their original packaging in the freezer. you can use them to calibrate
7500/7500 Fast instruments up to 3 times for 6 months after opening them.

5. After you remove the dye plate as instructed. click Finish.

6. Prepare and run the next plate as explained in “Prepare the Plates” on page 35.

Notes
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Troubleshoot the Dye Calibration

Problem/Symptom Possible Cause Action

Oma or more raw # The spectral calibration plate | 1. Unload the 75007500 Fast instrument and view the walls of

spactra are at or was centrifuged insufficienty. the spectral calibration plate. If the liguid in the walls is not:

balow the detectable | & Tha spectral calibration plate — At the bottom of the wells, centrifugs the plate for a longer
Eé]r?:shd_dnfnr the contains old or insufficient time, then repeat the calibration.

reagents.

+ [f you am running a custom
spectral calibration plate, the
dya may not be presant at a
sufficient concentration.

— Equivalent in wolurme, the plate is not sealed and the
reagents have evaporated. Discard it and run anothar.

2. If the spactral calibraticn plate appears to be normal, discard
the plate and run ancthar.

3. I the problam persists, contact Applied Biosystems as
explained in “How fo Obtain Support™ on paga x.

Mote: If you are running a custom spectral calibration plate,

craate another plata but increase the concantration of the dye

that produced insufficiant signal.

Oma or more raw

+ Fluorascent contaminants are

Viarify that contaminants are not presant by performing a

spactra excead the on the sample block(s) or background calibration as explained in Chapter 3, *Parform
makirnum limit for the speciral calibration plata. the Background Calibration and Optical Calibration.” If the
750047500 Fast o [ yOu M8 running & custom background calibration doas not show samiple block
instrument. SF:;.:trEJ ,:-_a]ibrg?bn plato, the | contamination, the spectral calibration plate may be
dys may be too concentrated. | SOntaminated.
- - Mote: If you are running a custom spectral calibration plate,

The spectra contain Fluorescent contaminants are o | craate another plate but decreass the concentration of the dye
peaks in mora than the =ample blockis) or spectral that excesds the detectable limit.
one filier. calibration plata.

Motes
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Chapter 5

E Verify the Instrument Performance

This chapter covers:
I T 46
B SetUptheExperiment . .. .. ... o it i iiiiiannases 45
B Runthe Experiment ... ... ... e 49
B Amnalyze the Experiment ... ... .. oL 51
B Troubleshoot the RNase P Experiment. .. ... oo i 4

MNote: For more information about any of the topics discussed in this guide. access the
Help from within Applied Biosystems 7500/7500 Fast Real-Time PCR. System Software
v2.0 by pressing F1. clicking @ in the toolbar, or selecting Help » 7500 Software Help.

Motes
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Oveniew

Overview

Time Required

Materials
Required

When to Perform
the RNase P
Experiment

About the
RNase P Plate

Notes

Perform the TagMan® RNase P Instrument Verification Plate run to verify the
performance of an Applied Biosystems 7500/7500 Fast Real-Time PCR System.

I hr
TagMan® RNase P
Instrument
Verification Plate
| ~==n 1
)
| !‘
L = 2
TagMan® RNasa P P i Centri = ith plate
Instrument Verification O\;Idoeresee % f:g::t;, .

Plate Kit

Applied Biosystems recommends performing an RNase P experiment:

» When installing the 7500/7500 Fast system. You must perform in sequence the ROI,
background. optical, and dye calibrations and the instrument verification run.

+ After moving the instrument to another location.

* As needed to verify the function of the 7500/7500 Fast instrument.

The RNase P plate is preloaded with the reagents necessary for the detection and quantitation
of genomic copies of the human RNase P gene (a single-copy gene encoding the RNase
moiety of the RNase P enzyme).

Each well contains:

* 1X TagMan® Fast Universal PCR Master Mix, No AmpErase® UNG

* RNase P primers

* FAM™ dye-labeled probe

+ Known concentration of human genomic DNA template
The figure below illustrates the arrangement of the standard and unknown populations on
the RNase P plate. The RNase P plate contains five replicate groups of standards (1250,

2500, 5000, 10,000, and 20,000 copies), two unknown populations (5000 and 10.000
copies), and negative control wells (NC).

PSS By e vt T S N s 1 UL
o

g" 5K-copy Unknown

K Popefation 1

) T STD 1250 | STD 2500

7| STD 5000 STD 10000 STD 20000
i} \
;‘, 10K-copy Unknown

,l Fopufation 2

—_— -
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After the run, the 7500 software:

Chanaow

1. Generates a standard curve from the averaged threshold cycle (Cy) values of the

replicate groups of standards.

2. Calculates the concentration of the two unknown populations using the standard

CUurve.

3. Calculates the following to assess the T500/7500 Fast instrument performance:

[ CopyUnk,)—3i T CopyUnk 1= [{CopyUnk )+ 3i “Cnpyunk]-:'l

where;

* CopyUnk, = Average copy number of unknown #1 (5,000-copy population)

O Copymir — Standard deviation of unknown #1 (5.000-copy population)

* CopyUnk, = Average copy number of unknown #2 {10,000-copy population)

Installation Specification

O copyumkz = Standard deviation of unknown #2 (10,000-copy population)

The T500/7500 Fast instrument passes the installation specification if the inequality
holds and the instrument successfully distinguishes between 5,000 and 10,000 copies

with a stahistical confidence level of 99.7%.

To meet the installation specification, you can omit a limited number of outlier wells

from the 5,000- and 10,000-copy unknown populations.

Maximum Number of Outlier Wells That Can Be Removed
Instrument Unknown Population Standard Neqati
5,000-copy | 10,000-copy (STD) Controls [NC)
7500 Systam
8 1] ] 0
7500 Fast System
Motes
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Set Up the Experiment

Prepare the TagMan® RNase P Fast Instrument Verification Plate for the run.

Prepare the IMPORTANT! Wear powder-free gloves when you handle the RNase P plate.
RMase P Plate

1. Obtain the TagMan® RNase P Fast [nstrument Venfication Plate from the freezer, then
allow the reaction plate to warm to room temperature (for approximately 5 min).

2. Remove the RMNase P plate from its packaging.

S

3. (Standard plates only) Vortex the plate for 5 sec.

IMPORTANT! Do not vortex Fast plates.

i The remaining steps apply to both standard and Fast plates.)
4. Centrifuge the reaction plate for 2 min at less than 1300 rpm.

IMPORTANT! The reaction plate must be well mixed and centrifuged.

5. Verify that the liquid is at the bottom of each well of the reaction plate. If not,
centrifuge the reaction plate again at a greater rpm and for a longer time.

IMPORTANT! Do not allow the bottom of the RNase P plate to become dirty. Fluids
and other contaminants that adhere to the bottom of the reaction plate can
contaminate the sample block(s) and cause an abnormally high background signal.

Incorrect
; N .
I'I
' ‘ Liquid is at the + Not centrifugad with enough forcs, or
." :I

bottom ofthewsll. | « Not centrifuged for snough time

MNotes
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Run the Experiment

After preparing the TagMan® ENase P Fast Instrument Verification Plate, load the plate
into the 7500/7500 Fast instrument and start the run.

Load the Plate m PHYSICAL INJURY HAZARD. During instrument operation, the
sample block can be heated to 100 “C. Before performing the following procedure, be

sure to wait until the sample block reaches room temperature.

1. Push the tray door to open it.

2. Load the plate into the plate holder in the instrument. Ensure that the plate is
properly aligned in the holder.

Load standard plates Load Fast plates (7500
(7500 system) with the Fast sy=tam) with tha

notched A12 position at notched A1 position at
the top-right of the tray. the top-left of the tray.

Motes
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Start the Bun 1. Inthe 7500 software, select Instrument ¥ Instrument Maintenance Manager.
2. In the Instrument Maintenance Manager, select the RNase P tab.
3. In the RMase P screen, click Start RNase ' Run.

4. Complete the calibration as instructed by the wizard.

The RMase P dialog box displays four tabs:
= Owverview — Displays information describing the calibration.
= Setup — Displays instructions for setting up the RMase P run. Clicking Next
prompts opens the Run tab.

* Run - Clicking START RUN starts the run process and displays the processing
messages. Clicking Next opens the Analysis tab.

* Analysis — Indicates the run status { Passed/Failed).

Mote: Before starting the run, the instrument may pause (up to 10 min) to allow the
heated cover to reach the correct temperature.
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Analyze the Experiment

Review the data to verify the results of the experiment.

Verify the Results  Note: After the 7500 software completes the RNase P run, it automatically analyzes the
of the Analysis  run and displays the results in the Analysis screen.

1. In the Analysis screen of the RNase P Run wizard, venify the status of the run:
+ Passed — The 7500/7500 Fast instrument passed the RNase P run. Go to step 5
on page 53.
* Failed — The 7500/7500 Fast instrument failed the RNase P run. Go to step 2 to
review the data for outliers.
If the run fails, the automated analysis may have included outliers that caused the
initial analysis to fail. Experimental error may cause some wells to be amplified
insufficiently or not at all. These wells typically produce C; values that differ
significantly from the average for the associated replicate wells. If included in the
calculations, these outlying data (outliers) can result in erroneous measurements.

2. In the Amplification Plot. select Ct vs. Well from the Plot Type drop-down list.

3. Verify the uniformity of each replicate population on the reaction plate (controls,
standards. and unknowns) by comparing the groupings of C; values:

a. In the plate layout. select the wells containing the 10,000-copy unknown
population (wells rows F, G, and H).

8t 8A0all 2
5K-copy Unknown
Population 1

STD1250 | STD 2500
STD 10000 | STD 20000

10K-copy Unknown
T ~ Population 2

b. In the plot, verify that the C.s of the replicate population are equivalent.

Note: The numbers on the X-axis of the plot correspond to the wells of the
reaction plate. Beginning with well Al. the wells are numbered from
left-to-right, and top-to-bottom.

Notes
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c. If an outlier is in the selected population, select the corresponding well in the
plate layout, then click Omit to remove the well from the analysis.

Maximum Number of Outlier Wells That Can Be Removed
Instrument ]
Unknown Population Staidasa Nzl
5,000-copy | 10,000copy | (STD) Conal (N0
7500 System
6 6 0 0
7500 Fast Systam

IMPORTANT! If the number of outliers exceeds the limit in the table above,
order another RNase P plate and repeat the experiment.

d. Repeat steps 3a through 3c for each replicate population (unknowns, standards,
and negative controls) on the reaction plate.

4. Click Reanalyze to analyze the run without the outliers.

If the status of the RNase P Run is “Failed” after performing steps 2 through 4, repeat
the RNase P experiment using a different RNase P plate. If the problem persists,
contact Applied Biosystems as explained in “How to Obtain Support™ on page x.
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Anahre the Experiment

5. Review the standard curve:
a. Select the Standard Curve tab.
b. Click the upper-left corner of the Plate Layout to select all wells.
c. Verify that the R2 value is greater than or equal to 0,990,

If the R2 value is less than 0.990, repeat the RNase P experiment using a different
RMase P plate. If the problem persists, contact Applied Biosystems as explained in
“How to Obtain Support™ on page x.
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6. Click Next, then remove the calibration plate.
mmm PHYSICAL INJURY HAZARD. During instrument operation,
the sample block can be heated to 100 °C. Before performing the following procedure,
be sure to wait until the sample block reaches room temperature.
a. Push the tray door to open it.
b. Remove the calibration plate.
¢. Push the tray door to move it into the instrument.
7. Discard the plate.
8. Click Finish. then click Yes when prompted to save the experiment.
Notes
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Troubleshoot the RNase P Experiment

Problem/Symptom Possible Causa Action

More than tha * Possible contamination Contact your Applied Biosystems sarvice and salas

maximum number of |« Pipatiing inaccuracy representative to order a replacemant TagMan® AMase P
outliers are presant Instrument Verification Plate. If the replacement RNasa P plate
in ANasza P data fails, contact Applied Biosystams technical support or your

sarvice representative for furher assistance.

The BNasza P plate + Insufficient centrifugation

varification run failed | - Defective plate seal PHYSICAL INJURY HAZARD. During

instrumeant operation, the sample block can be heated to
100 °C. Before parforming the following procedura, be sure to
wait until the sample block reaches room temperature.
1. Unload the RMasa P plate from the instrument:
a. Push the tray door to open it.
b. Ramovea the BMasa P plate from the tray.
¢. Push the tray back into the instrument.

2. Hold the plata up to a light source, and verify that all walls
contain the same volume of fluid.
If thare are differencas in fluid volumes, check the heat seal
of tha walls with lowear volumeas for signs of damage or
evaporation.
Also, compare the position of the wells that have lower
volumes with the outliers that you have removed from the
plate. If tha weall positions coincida, tha haat saal on the
plate may be defective and resulted in the avaporation of
the associated samples.

3. Contact your Applied Biosystems service and sales
representative to order a replacement Taghan® BNass P
Instrument Verification Plate. If the replacement EMase P
plate failz, contact Applied Biosystams tachnical support or
your service represantative for further assistance.
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Chapter 6

User-Performed Maintenance

This chapter covers:

B Monitor the T500/7500 Fast System. .. ... ..o i i 56

B Viewthe Instrument Log ... ... oo 56

B Monitor the Instrument Status ... ... ..o oo il 57

B Monitorthe Lamp Status ... . ... L o 58
B Decontaminate the Sample Block. ... ..o oo oo oo 59
B Monitor the TS00/7500 Fast System. . ... ... o i 58
B Replace the Halogen Lamp. . .. ... o oo 63
B Replace the Instrument Fuses. .. ... ..o i i 66
B Update the Windows Operating System .. ... ... .. .o i &7
B Update the 7500 Software. .. ... ... o 68

Mote: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems 7500/7500 Fast Real-Time PCR System Software
v2.0 by pressing F1. clicking @ in the toolbar, or selecting Help » 7500 Software Help.

Motes
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Monitor the 7500/7500 Fast System

You can monitor the state of the Applied Biosystems T500/7300 Fast Real-Time PCR
Systemn using the Function Test, Lamp StatusReplacement, and Instrument Log tools of
the 7500 software. The tools enable you to assess the health of the 7500/T500 Fast system,
check the replacement status of the instrument lamp. and view a recent history of
imstrument activity.

View the Instrument Log

Use the Instrument Log to view the recent event history of the 7500/7500 Fast system. The
log displays the major instrument activity for either the most recent 25 runs (including
calibrations), or the events that pertain only to a specific EDS file.

Display the 1. Inthe 7500 software, select Instrument » Instrument Events Log.

Instrument Log
2. In the Instrument Events Log dialog box, select either:

* System Log — To view events that occurred during the 25 most recent runs
{experiments) or calibrations.

* Document Log — To view events that pertain only to the experiment currently
open in the 7500 software.

3. If necessary, modify the data displayed by the table by filtering the data and adding
or removing columns.

To... Action

Fitter the data in the 1. In the Filter drop-down list, salect a proparty.

events tabls 2. Enter the appropriate conditions into the drop-down lists
and fields that appear automatically.

3. Click Apply to filter the data.
Mote: To reset the log, select Filter » Show All Records.

Add or remove columns | Click Show Columins, then salect the column desired column
tovfrom the events table | in the drop-down list.

Sort the data in the Click tha haading of the column of interest once to sort tha
avants table data in ascending onder. Click the column heading again o
=ort the data in revarss order.

Export the contents of 1. Salect the rows of interest in the avent table,
};‘g instrument evant | 5 precs Girl+C to copy the data.

3. Paste the data into a spreadshesat application or a text fila.
Mote: The softwars exports the data in tab-delimited format.

4. When you finish viewing the events, click the close box to close the dialog box.

MNotes
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Monitor the Instrument Status

Use the Function Test dialog box to perform a high-level diagnostic of the major
T500/7500 Fast system components. In general, you need not perform the function tests
unless you expenience a suspected hardware failure, or you are instructed to do so by an
Applied Biosystems representative.

Perform Function 1. Inthe 7500 software, select Instrument » Function-Test.

Tests of System _
Components 2. Perform function tests as needed.

To test:

= All system components — Click All Tests, then wait for the software to perform
all of the function tests.

* One or more specific components — Click one or more of the following.
USB — Tests the universal senal bus (L'SB) connection between the
T500/7500 Fast instrument and computer. The test passes if the 7500 software
can establish communication with the 7500/ 7500 Fast instrument.
CCIy — Tests the CCD camera in the 750007500 Fast instrument. The test
passes if the camera can capture an image.
Filter Wheel — Tests the filter wheel in the 7T500/7500 Fast instrument. The test
passes if the filter wheel controller is running the correct version of firmware.

Shutter — Tests the optic shutter of the 7500/7500 Fast instrument. The test
passes if the shutter controller is running the correct version of firmware.

Lamp — Tests the halogen lamp of the 7500/7500 Fast instrument. The test
passes if the lamp controller is running the correct version of firmware.
Thermal Cyeler — Tests the thermal cycler sample block in the 7500/7500 Fast
instrument. The test passes if the thermal eyeler controller is running the
correct version of firmware.

When the 75300 software completes a test, the software reports the pass/fail status of
the test and provides a description of the outcome.

Fanciisn Test

Tasl PassFal  Deserpion
Pags LIS6E chack pagssd

Pass 'l_"\'_'bl-:m-:upissw

| Pasc Ehuthar chack paszad

|
|
Fibwr Whed | Pass FiterWhaal chack passad
|
|

| Fass Lamp check passsd.

Tl'-'r-:\'-\fl=|-'| Paex [Thermo Cycler chack pasmsd.

AlTesis | Pass

e |

3. When you finish testing, click Close.
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Monitor the Lamp Status

Use the Lamp Status/Replacement dialog box to monitor the status of the halogen lamp
that the 7300,/7500 Fast instrument uses to illuminate samples during runs.

Check the Lamp  Inthe 7500 software, select Instrument » Lamp Status/Replacement to determine the status
Status  of the halogen lamp.

Larsp States § Aeplecement

umaim Lamp Saius

Candison: Caad
Usape Hours o

Lamp curman Likrern
Oale Last Replaced:  10M12007
Risglacs Lmg

¥ou must resatthe lamp trmer
aterreplacirg e lamp

FAITE: Tha lamp tmercan only b
gt whan Mg ingnamsan s idis ]

Peznt Lng T |

Qs |

The Lamp Status/Replacement dialog box displays:
* Condition — Indicates one of the following conditions:
— Good - The lamp is functioning well and does not need to be replaced. Click Close.

— Failed — The lamp bulb must be replaced. Click Close, then replace the lamp as
explained in “Replace the Halogen Lamp™ on page 63.

— Change Soon — The lamp usage is above 2000 hrs; Applied Biosystems recommends
that you replace it. Click Close, then decide whether or not to replace the lamp. [f you
choose to replace the lamp, see “Replace the Halogen Lamp™ on page 63.

* Usage (Hours) — The total number of hours that the lamp has been illuminated.

* Lamp Current — The output current of the lamp in amperes (A). Low current can
indicate a potential future failure of the lamp.

= Date Last Replaced — The date of the last lamp replacement.

Warnings The 7500 software can display the following warnings before or during a run:

Massage Description
Waming - Cannot detect sufficiant currant | The lamp current is below the acceptable leval at the start of thi run. You cannot
from lamp. Either lamp is not installed procesd with the nun until you replace the halogen bulb as explained in “Replacs
propary or neads to be replaced. the Halogan Lamp™ on paga 63.
Waming — Cannot detect sufficient current | The 7500 software stopped the run because the lamp curmant decreased below the
from lamip. Either lamp is not installed accaptabla leval during the run. You cannot procesd with the run until you replacs
propary or neads to be replaced. the halogen bulb as explainad in “Heplacs the Halogen Lamp™ on page 83. Click

OK in the message box, inspect the Instrument Log, then replacs the lamp bulb.

Warning - The lamp usage has sxcesdad The lamp usage sxceeds 2000 hr at the start of 3 run. Click Canceal Run, than
2000 hr. We recommend replacing the lamp | replaca the lamp, or click Continue Run.

s00n to ensure aplimal assay periomance. | oo o ooy Background, Optical and Dye calibrations.

MNotes
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Decontaminate the Sample Block

Perform the following procedure to eliminate fluorescent contaminants from the sample
block of the 7300/7500 Fast instrument. Fluorescent contamination is generally evident
in failed background runs where one or more wells consistently exhibit abnormally high
signals.

PHYSICAL INJURY HAZARD. Do not remove the instrument cover.

There are no components inside the 75007500 Fast system that you can safely service
yourself. If you suspect a problem, contact an Applied Biosystems Service Representative.

PHYSICAL INJURY HAZARD. During instrument operation, the

sample block can be heated to 100 °C. Before performing the following procedure, be sure to
wait unti] the sample block reaches room temperature.

Before using a cleaning or decontamination method other than those

recommended by the Applied Biosystems, verify with Applied Biosystems that the proposed
method will not damage the equipment.

Time Required 30 min

Materials 5% ethanol 0% bleach -
Required solution solution ; asgtg}.rs S
@ fj = =g
| ! Caotton or nylon
L swabs and
Pipette (100-pL) lint-free cloths
with pipette tips
Deionized
watar

Clean the IMPORTANT! Wear powder-free gloves when you perform this procedure.

Sample Block
1. ldentify the contaminated wells of the sample block (see “How to Identify
Contamination™ on page 30).
2. Remove the plate and the tray holder from the 7500/7500 Fast instrument:
a. Push the tray door to open it.
b. Remove the plate and the tray holder.
Motes
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c. Close the tray door. Apply pressure to the right side of the tray door at an angle.

3. Manually raise the block:

a. In the 7500 software, select Instrument » Instrument Maintenance
Manager.

b. In the ROI tab of the Instrument Maintenance Manager, click Start Manual
Calibration.

c. In the ROI Inspector dialog box. click Move Block.
d. When the ROI Inspector dialog box displays “Block Down,” click Done.

4. Power off. then unplug the 7500/7500 Fast instrument. Allow it to cool for 15 min.
5. Open the access door to the 7500/7500 Fast instrument.

a. Insert a thin screwdriver into the keyhole on the edge of the access door, then
push to unlatch the door.

b. Open the access door.

6. Lift the latch, then push the heated cover door to the back of the instrument.

Notes
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7. Clean the contaminated wells of the sample block using a small volume of deionized
water:

a. Pipette a small volume of deionized water into each contaminated well.
b. Pipette the water up and down several times to rinse the well.

Pipette the water to a waste beaker.

a o

. Using a cotton swab, scrub inside of each contaminated well.

Using a lint-free cloth, absorb the excess deionized water.

e

8. Pull the heated cover door to the front of the 7500/7500 Fast instrument. Lift the
latch. then secure the heated cover door to the cross bar.

10. Plug in, then power on the 7500/7500 Fast system.

11. Verify that you have eliminated the contamination by performing a background
calibration run (see “Perform the Background Calibration™ on page 20).

Notes
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12,

13,

14,

15.

16.

MNotes

If the contamination remains, repeat steps | through &, then clean the contaminated
wells of the sample block using 95% ethanol solution:

a. Pipette a small volume of 95% ethanol solution into each contaminated well.

b. In each contaminated well, pipette the solution up and down several times to
rinse the well.

c. Pipette the ethanol solution to a waste beaker.

IMPORTANT! Always use deionized water to rinse wells after cleaning with bleach
or ethanol solution.

Repeat steps 7 through 11 to rinse the wells of the sample block and to verify that
you have eliminated the contamination.

If the contamination remains, repeat steps | through 6, then clean the contaminated
wells of the sample block using 10% bleach solution:

a. Pipette a small volume of 10% bleach solution into each contaminated well.

b. In each contaminated well, pipette the solution up and down several times to
rinse the well.

c. Pipette the bleach solution to a waste beaker.

IMPORTANT! Always use deionized water to rinse wells after cleaning with bleach
or ethanol solution.

Repeat steps 7 through 11 to rinse the wells of the sample block and to verify that
you have eliminated the contamination.

If the contamination remains, contact Applied Biosystems support {see “How to
Obtain Support™ on page x).

Ensure that the heated cover door is completely closed and latched. If it is not, the
T500 software displays an error message.
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Replace the Halogen Lamp

Replace the halogen lamp after approximately 2000 hr of life.

PHYSICAL INJURY HAZARD. The 7500/7500 Fast system and

lamp are hot! The lamp can become very hot while in use. Allow the lamp to cool for
|5 min and put on protective, powder-free gloves before handling it.

PHYSICAL INJURY HAZARD. Wear disposable, powder-free

gloves when handling the lamp to prevent burns and to prevent shortening the life of the
replacement lamp.

WARNINCG. This instrument is designed for 12V, 75 W halogen

lamps only.

Time Required 30 min

Materials
Required @ \\

s
o

Halogen bulb  Screwdriver,  Powder-frae Safaty

{12V, 75 W) small gloves glaszes

Replace the IMPORTANT! Wear powder-free gloves when you handle the lamp.

Lamp
1. Power off, then unplug the 7500/7500 Fast system. Allow the instrument to cool for
15 min.
2. Open the access door to the 7500/7500 Fast system:
a. Insert a thin screwdriver into the keyhole on the edge of the access door, then
push to unlatch the door.
b. Open the access door.
Notes
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3. Remove the lamp from the instrument:
a. Slide the lamp release lever downward.

b. Firmly grasp the lamp and lift it up and out of the slotted mount.

IMPORTANT! Do not touch the lamp without powder-free gloves. Finger prints
shorten the lamp life.

4. Inspect the lamp for signs of failure (carbon typically coats the inside of failed
lamps).

5. Install the new lamp into the instrument:
a. Slide the lamp release lever upward.

b. Firmly grasp the lamp, place it into the slotted mount, then carefully slide the
lamp downward into place.

Notes

64 Appliad Biosystems 7500/7500 Fast Real-Time PCR System Maintenance Guide

-

All copies of this document are uncontrolled when printed.



Procedure for Calibration and Equipment Maintenance Version 11
Forensic Biology Section Effective Date: 12/28/2015
Issued by the Forensic Biology Forensic Scientist Manager and DNA Technical Leader

Chapter 6 User-Performed Maintenanca
Replace the Haiogen Lsmp 1A ®

6. Close the access door.

7. Plug in and power on the 7500/7500 Fast system.

8. Open the ROI Inspector dialog box:

a. In the 7500 software, select Instrument » Instrument Maintenance
Manager.

b. In the ROI tab of the Instrument Maintenance Manager. click Start Manual
Calibration.

9. In the ROI Inspector dialog box, select Lamp Control » Idle.

10. While the instrument is running, look through grating of the access door and verify
that the lamp is illuminated, then click Done.

11. Ifthe lamp is illuminated. select Instrument » Lamp Status/Replacement in the 7500
software, click Reset Lamp Timer, then click OK.

If the lamp is not illuminated, the replacement halogen lamp may be defective.
Replace the lamp again. If the second lamp does not illuminate. check the
instrument fuses for failure (see page 66).

12. Perform the following calibrations after replacing the lamp. See:
* Chapter 2, Perform the Regions of Interest (ROI) Calibration
* Chapter 3, Perform the Background Calibration and Optical Calibration
» Chapter 4. Perform the Dye Calibration
« Chapter 5, Verify the Instrument Performance

Notes
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Replace the Instrument Fuses

Replace the 7500/7500 Fast instrument fuses when the fuses fail.

m FIRE HAZARD. For continued protection against the risk of fire,

replace fuses only with listed and certified fuses of the same type and rating as those
currently in the instrument.

Time Required 30 min

Materials £
Required &> -
®¢ S
Fusas (2), :
5 % 20 iy gloves glasses

Replace the 1. Power off the instrument, then unplug it.

Fuses ) )
2. Using a flat-head screwdriver. unscrew and remove the fuse holders from the

instrument.

3. Remove each fuse from its fuse holder and inspect it for damage. Carbon typically
coats the inside of failed fuses.
? Good fuse

Q— ‘4
\

Notes
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4. Replace each failed fuse witha 12.5 A, 250V, 5 x 20-mm fuse.

Note: The voltage and amperage ratings are on the fuse holder.

5. Install the fuse holder.

6. Plug in, then power on the instrument.

The installation is successful if the instrument powers on.

Mote: Fuse failure can result from fluctuations in the supplied power to the instrument.
To prevent further failures, consider installing an electrical protective device, such as a

UPS or other surge protector. For more information about fuses, see the 7500/7500 Fast
Site Preparation Guide.

Update the Windows Operating System

Do not upgrade or update the Microsoft Windows® operating system of the computer
running the 7500 software without first consulting the software release notes or the
Applied Biosystems website. Future versions of the Windows® operating system and
updates to the operating system can conflict with the 7500 software.

Determine 1. Open DY\Applied Biosvstems\7500 Software v 2.0, double-click release-notes.himl,
Compatibility of then read the 7300 Software Release Notes for the compatibility of interest.
an Upgrade or _ L _ .
Update 2. Ifthe release notes do not mention the compatibility, use an internet browser to visit
www.appliedbiosystems.com, then search the website for the compatibility of
interest.

3. If the website does not contain the information of interest, contact
Applied Biosystems (see “How to Obtain Support™ on page x).

Motes
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Update the 7500 Software

If you want to update the 7500 software, prepare your computer by exporting the
application libraries and backing up your experiment files.

Visit the Applied  You can obtain 7300 software updates directly from the service section of the
Biosystems Applied Biosystems website. For the latest services and support information for the
Website 7500/7500 Fast instrument:

1. Go to https://'www2l.appliedbiosystems.com/support/software/

2. In the Software Downloads page, select the appropriate instrument from the
drop-down list.

3. In the Software Downloads page for your instrument, click Updates - Patches.
The website opens the page describing the latest software updates for the 7500 software.

Prepare for the Before updating the 7500 software:

Upgrade o
1. Back up the application libraries:

a. In the main menu of the 7500 software, select Tools ¥ <desired library=.

b. When the library dialog box opens, select the element(s) that you want to
export, then click Expaort.

c. Inthe Export dialog box, click Save to archive the selected records.

d. Repeat steps la through le for the remaining libraries to archive them.

2. Back up all experiment files by creating a copy of the directory that you are using to
store files.
The default directory for experiments is:

D:\Applied Biosystems\ 7500hexperiments

MNotes
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Appendix A

“ Store, Move, and Install the
- 7500/7500 Fast System

This chapter covers:

B Store the 7500/7500 Fast System . ... ... ... 70
B Move the 750007500 Fast System . ... ..o o it iiiiiiaaeaaases 71
B Set Up the 7500/7500 Fast System. ... ... oot iiiiaiaaaaees 73

Mote: For more information about any of the topics discussed in this guide. access the
Help from within Applied Biosystems 7500/7500 Fast Real-Time PCR System Software
v2.0 by pressing F1. clicking @ in the toolbar, or selecting Help ¥ 7500 Software Help.

Motes
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Store the 7500/7500 Fast System

Time Required

Materials
Required

Prepare the
Instrument

MNotes

The Applied Biosystems 7500/7500 Fast Real-Time PCR. System can be powered off and
stored for extended periods of time. The length of the period of inactivity determines the
method you use to power off the instrument.

5 min

ABI Prism® Optical 96-Well Reaction Plate or Optical 96-Well Fast Plate (unused)

1. Open the instrument tray door.
2. 1f the tray contains a plate, remove it.

3. If you plan to store the 7500/7500 Fast instrument for more than a week or you plan
to move the instrument, load an unused plate into the tray.

Note: The empty plate protects the internal components of the T500/7500 Fast
mstrument during transport or during periods of inactivity lasting more than a week.

4. Push the tray door to move it into the instrument.

5. Press the instrument power button.

6. Power off the computer and monitor:
a. Select Start » Shut Down.
b. Inthe Shut Down Windows dialog box. select Shut Down.
c. Power off the monitor.
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Move the 7500/7500 Fast System

Perform this procedure to safely move the T500/7500 Fast instrument short distances ( for
example, between laboratories of the same building).

PHYSICAL INJURY HAZARD. Do not attempt to lift the

instrument or any other heavy objects unless you have received related training. Incorrect
lifting can cause painful and sometimes permanent back injury. Use proper lifting
techniques when lifting or moving the instrument. At least 2 people are required to lift
the 7500/7500 Fast system.

IMPORTANT! Moving your Applied Biosystems 7500/ 7300 Fast Real-Time PCR. System
can create subtle changes in the alignment of the instrument optics.

Materials ABI Prism® Optical 96-Well Reaction Plate and Optical 96-Well Fast Plate (unused)
Required

Prepare the 1. Load the empty reaction plate into the 7500/7500 Fast instrument.

Instrument ) )
2. Using the ROI Inspector, manually raise the sample block:

a. In the 7500 software, select Instrument » Instrument Maintenance
Manager.

b. In the ROI tab of the Instrument Maintenance Manager, click Start Manual
Calibration.

c. In the ROI Inspector dialog box, click Block Up.
3. Power off the T500/7500 Fast instrument and computer.
4. Disconnect all 7500/7500 Fast system components.

5. Move the 7500/7500 Fast system according to the
following guidelines:
= Verify that the surface on which you will place
the instrument can support at least 54.5 kg
(120 Tbs).

» Verify that the pathway to the final position of
the instrument is clear of obstructions.

* Keep your spine in a good neutral position.

* Bend at the knees and Iift with vour legs.

* Do not lift an object and twist your torso at the same time.

* Cpordinate your intentions with your assistant before lifting and carrying.
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Move the 7500/7500 Fast System

6. Reconnect the components of the 7500/7500 Fast system (see “Set Up the
7500/7500 Fast System” on page 73).

7. Run a TagMan® RNase P Instrument Verification Plate (see page 45).

a. If the run passes, recalibrations are not necessary.

b. If the run fails, perform steps & through 12 to recalibrate the instrument.
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Notes

8. Perform an ROI calibration (see page 13).

9. Perform a background calibration (see page 23).

10. Perform an optical calibration (see page 25).

11. Perform a dye calibration (see page 32).

12. Perform an instrument verification run (see page 45).
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Appendix A Store, Move, and Install the 7500/7500 Fast Systemn “
Sat Up the 7500/7500 Fast Systam o)

Set Up the 7500/7500 Fast System

Set Up the Refer to the Applied Biosystems Real-Time System Computer Setup Guide for
Computer information on setting up a computer for use with the 7500/7500 Fast instrument.

Set Up the IMPORTANT! Do not connect the USB cable to the 7500/7500 Fast instrument until you are
7500/7500 Fast instructed to do so by this guide.

Instrument
Matenials Required
* Phillips screwdriver (small and thin)
* Power cord
Set Up the 7500/7500 Fast System

1. Prepare the installation site as described in the Applied Biosystems 7500/7300 Fast
Real-Time PCR System Site Preparation Guide.

2. Open the access door to the 7500/7500 Fast instrument.

a. Insert a thin screwdniver into the keyhole on the edge of the access door, then
push to unlatch the door.
b. Open the access door.

3. Verify that the heated cover assembly is pulled fully toward the front of the
instrument. If the 7500/7500 Fast system has a heated cover latch installed. check
that the latch is in a locked position.

4. Inspect the instrument for damage caused by the transportation of the 7500/7500
Fast system.

If the instrument is damaged. record the location and appearance of the damage.
then contact Applied Biosystems technical support or your service representative for
assistance.

5. Close the access door.

6. Connect the power cord to the 7500/7500 Fast instrument, then to the wall
receptacle.

Note: Power cords for different voltages are provided in the packing kit. Connect
the cord with the receptacle appropriate for your voltage. then discard the remaining
power cords.

7. Press the power button at the lower right front panel, then wait for the 7500/7500
Fast instrument to start up (about 30 sec).

Notes
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“ Appendix A Store, Move, and Install the TR00/7E00 Fast System
—~ Sat Up the 7500/TS00 Fast Systam

8. When the Power status light on the lower left front panel is lit, push the tray door to
open it.

9. Remove the packaging plate from the tray and set it aside.

10. Close the tray door, then press the power button again to power off the instrument.

Note: Install any additional hardware.

IMPORTANT! Do not connect the USE cable to the 7500/7 500 Fast instrument at
this time.

11. Verify that the 7500 software is installed to the computer.

If the computer does not have the 7300 software, use the Applied Biosystems 75007500
Fast Real-Time PCR System Software v2.0 Software CD to install the software.

12. Once you verify that the computer contains the 7500 software, connect the USB
cable to the 7500/7500 Fast instrument.

MNotes
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Appendix B

-
n Create a Custom Dye Plate

The Applied Biosystems 750007500 Fast Real-Time PCR System can be used to run
assays designed with custom dyes (dves not manufactured by Applied Biosystems).

Custom dyes must fluoresce within the 520 to 650 nm spectral range measured by the
T500/7500 Fast instrument.

Before Using Before using custom dyes with the 7500/7500 Fast instrument, you must:
Custom Dyes + Determine optimum dye concentration

» Create a custom dye plate

« Add the custom dye to the software

* Perform a dye calibration (see Chapter 4, “Perform the Dye Calibration.™)

Materials Pipettors and
Flequired pipette tips Wiater, Tubes Safoty
{200-pL and 1000-pL)  deionized (2-mL and 10-mL} glasses

Custom
it N\ o

!

AB| Presm® Optical 96-Well Optical Adhesive Covear Powdear-fres
Reaction Plate and Optical or Optical Fat Caps glovas
28-Well Fast Plate

Motes
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m Appendix B Craate a Custom Dye Plate

Determine IMPORTANT! Wear powder-free gloves while creating the dye plate.
Optimum Dye
Concentration

1. In the center wells of a 96-well plate. prepare a dilution series of the custom dye (for
example, 25. 50, 100, 200, 400, 800, 1600, and 3200 nM) using 50-pL volumes for
the 7500 system or 20-pL volumes for the 7500 Fast system.

00.00
0000

400 800 16003200

2. Seal the wells of the reaction plate using an optical adhesive cover.

3. Load the prepared reaction plate:
a. Push the tray door to open it.
b. Load the dye plate into the plate holder.
c. Push the tray door to close it.

4. In the 7500 software, select Instrument » Instrument Maintenance Manager.

5. In the ROI tab of the Instrument Maintenance Manager, click Start Manual
Calibration.

6. In the ROI Inspector, create the ROI image for each filter, beginning with Filter I:
a. In the Exposure Time field. enter 1024.
b. Click Block Up.
c. Select Filter 1.
d. Click Snapshot.

Notes
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e. Inspect the image for saturation.

- Mormal Over
No Saturation | o ration Saturation

Accaptable Mot Accaptable

f. Record the coordinate of the well that displays the brightest possible signal

without saturation. This well contains the optimal concentration of the custom
dye for Filter 1.

0 Caonial ™S sting:

Enpoaum Tirw jnz] [ W%
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7. Repeat steps bc through 6f for the remaining filters.

8. After you determine the optimum concentration for each filter, determine the
optimum concentration for the custom dye:

a. Compare the results from all filters.

b. Select the concentration that yields the highest possible signal in all filters, but
does not saturate.

Motes
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m Appendix B Craate a Custom Dye Plate

Unload the Plate PHYSICAL INJURY HAZARD. During instrument operation, the
sample block can be heated to 100 °C. Before performing the following procedure, be
sure to wait until the sample block reaches room temperature.

1. In the ROI Inspector, click Block Down.

2. Remove the plate from the instrument:
a. Push the tray door to open it.
b. Remove the plate.

c. Push the tray door to move it into the instrument.

Note: If you cannot open the tray. the sample block may be in its raised position, locking
the tray position. To lower the block, click Move Down, then click Block Down.

3. Click Done.

Create a Custom IMPORTANT! Wear powder-free gloves while creating the dye plate.
Dye Plate

1. Prepare 5 mL (7500 system) or 2 mL (7500 Fast system) of the custom dye at the
concentration determined in step 8 on page 77.

2. Pipette 50 pL (7500 system) or 20 pL (7500 Fast system) of the diluted custom dye
to all wells of an optical reaction plate.

3. Seal the wells of the reaction plate using an optical adhesive cover.

\ ]

4. Centrifuge the plate for 2 min at less than 1500 rpm.

IMPORTANT! The custom dye calibration plate must be well mixed and centrifuged.

Notes
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5. Werify that the liquid in each well of the ROI calibration plate is at the bottom of the
well. If not, centrifuge the plate again at a higher rppm and for a longer period of time.

Incorrect
.
a I
qud is at « Not centrifugad with enough forca,

bottom of well. ar
+ Mot centrifugad for enough time

Cormect

Add the Custom 1. In the main screen of the 7500 software, select Instrument »
Dye to the Instrument Maintenance Manager.
Software

2. Inthe Instrument Maintenance Manager:
a. In the navigation pane, click Dve.
b. In the Dye screen, select Custom Dive Calibration.

. Click Start Calibration.

3. In the Setup screen of the Dye Calibration dialog box, select a custom dye from the
list or create the custom dye as follows:

a. Click New Dye.
b. In the Dyve Manager dialog box, click New.
c. Complete the Mew Dye dialog box, then click OK.

Field/Option Action

Mams Entar a name for the custom dye.

Wavealength Entar thewavalangth at which the dya fluoresces.

Type Select:
+ Reporter if the dye works in conjunction with a guancher dys
to report an increasa of PCR product.

+ Quencher if the dye suppresses the fluorescence of a reporter
dye until amplification of PCR product.

+ Both if the dye reports an increase of PCH product without the
aid of a guanchar dya.

d. Click Close.

Motes
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| ]

MNotes

. In the Setup screen of the Dye Calibration dialog box, enter a temperature setting for

the calibration.

Note: Set the temperature to match the temperature at which you intend to collect
data. For example, the temperature for all Applied Biosystems system dyes is 60 °C

because data collection for TaghMan® reagents occurs during the 60 °C extension
step of the PCR.

. Select The custom dye plate is loaded in the instrument, then click Next.

. In the Run screen, click Start Run, then want for the 7500¢7500 Fast instrument to

complete the dye calibration.

Note: 1fthe 7500 software displays messages during the run, troubleshoot the errors
as described in “Troubleshoot the Dye Calibration™ on page 43.

. When the 7500/ 7500 Fast instrument displays the Main Menu, unload the custom

calibration plate.

. Analyze the custom spectral calibration as explained in “Analyze the Calibration

Data™ on page 30.
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Appendix C

m Create a Background Plate

Whenever possible, use a background plate that is included with the spectral calibration
kit. The plates supplied in the kit contain a buffer that accurately simulates the reagents
used for PCR, and, therefore, produces high-quality calibration data. However, if a
background plate from a spectral calibration kit 1s not available. you can create one as
described below.

Materials Pipettor, 200-uL Deionized
Required (with pipatta tips) watar Safoty glazses

=l

Applied Biosystams Optical Optical Adhesive Powdar-frea
o28-Weall Reaction Plate or Cower or Optical gloves
g8-Well Fast Reaction Plate Flat Caps

Create a IMPORTANT! Wear powder-free gloves while creating the background plate.
Background Plate

1. Remove an Applied Biosystems 96-Well Optical Reaction Plate or 96-Well Fast
Reaction Plate from its box and place it on a clean, dry surface.

2. Aliquot 50 pL (7500 system) or 20 pL (7500 Fast system ) of delonized water to each
well of the reaction plate.

3. Seal the plate using an optical adhesive cover or optical flat caps.

Use the plate for background calibration in the same way you use a background
plate from the spectral calibration kit. See Chapter 3, “Perform the Background
Calibration and Optical Calibration,”

Motes
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m Appendix C Creata a Background Plate

MNotes
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perform 23 materials required 32
preparation 21 perform 36
troubleshoot 30 preparation 15
background fluorescence 20 specira E_Jr\'ﬁél-tl.ﬂl"ltt;ﬂ 34
spectra, 75
background plate
how fo create 81 troubleshoot 43
prepare 21
bichazardous waste, handling xix E
biological hazard guidelines xxi electrical safety xx
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chemical waste disposal xix
chemical waste safety xix

H

halogen lamp. See lamp

hazard icons. See safety symbols, on instruments
hazard symbols. See safety symbols, on instruments
hazards. See safety

Help system, accessing ix

IMPORTANT, description xii
installation

background calibration 20
decontamination 59
dye calibration 32
fuse replacement &6
lamp replacement 63
opfical calibration 25
EMase P experiment 46
RO calibration 8
move, instrument 71
moving and lifting, safety xvi
moving parts, safefy xx
MSDSs
description xvii
obtdining x, xvii

halogen lamp 63—635 N
instrument fuses 6667
operating system updates 67 NED™dye 33, 41
specification 47
installation category xx (8]
nsirument omit well 51

background calibration 20—24
dye calibration 32—42

dye calibration (custom) 7530
load 49

move 71

optical calibration 2529

online Help. See Help system

operating system, update &7

optical calibration 2529
analyze the data 28
materials requirad 25

prepare for storage 70 perform 23
RMase P experiment 46—353 preparation 25
RO calibration 817 troubleshoot 30
setup 73 outliers 5

instrument fuses BTV i
replacement 66—67 overvoltape catepory (rating) xx
specification &6 P

instrument log, view 36

instrument operation, safety xvi perform

background calibration 23
dye calibration 36

J opfical calibration 28
JOE™ dye 33, 41 RMase P experiment 49
RO calibrationm 12
L physical hazard safety xx
) plate
Lamp function test 57 background 21
lamp replacement 63—65 dye 35
failed lamp, example 64 Fast 9
lamp removal 64 BMNase P 46, 43
materials required 63 ROI 9,25
safety 63 standard 9

lamp status, view 58
lamp timer, reset 58
lamp, life span 63

load, instrument 49

background calibration 21
dye calibration 35
opfical calibration 25
RMase P experiment 48
RO calibration 9

ROI plate 25
M
materials required
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